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Chapter 1: Getting Started

Chapter 1: Getting Started 
Kidspiration® is the visual way to explore and understand words, 
numbers and concepts. Created for pupils ages 4-10, Kidspiration 
develops literacy, numeracy and thinking skills using the proven 
principles of visual learning. Kidspiration supports personalised 
learning as pupils think creatively and organise ideas to write, 
comprehend and communicate successfully. 
In literacy, Kidspiration builds pupils’ word recognition, vocabulary, 
comprehension and written expression using visual tools that combine 
pictures, text and spoken words. 
With visual maths tools, pupils build a strong mathematical foundation 
for reasoning and problem solving by using visual representations to 
understand numeracy concepts.
Across the curriculum, they express and communicate their thinking 
with pictures, words and numbers.
This guide is designed to help you get started using Kidspiration, 
quickly and easily. It contains:
• What’s new in Kidspiration 3

• System requirements

• Installation instructions

• Customer service information

• Learning Kidspiration Tutorials

:KHUH�WR�¿QG�PRUH�LQIRUPDWLRQ�
• The Kidspiration Help system contains detailed information about 

using Kidspiration commands and features. To access Help while 
you are using Kidspiration, click Kidspiration Help on the Help 
menu.
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• This Getting Started Guide is available as a PDF document in the 
Documentation folder inside the Kidspiration 3 IE folder. To access 
the Getting Started Guide while you are using Kidspiration, click 
Kidspiration Documentation on the Help menu.

• Kidspiration Technical Support is available online. To connect to 
Technical Support while you are using Kidspiration, on the Teacher 
menu, point to Teacher Resources Online, and then click  
Technical Support.

What’s New in Kidspiration 3
With new and enhanced capabilities, Kidspiration 3 helps pupils 
develop strong thinking skills, improve their literacy skills and build 
conceptual understanding in maths.

Additional Support for Building Strong  
Thinking Skills
Enhanced Symbol Library

To further support the development of strong thinking skills as 
pupils visually explore ideas and concepts, Kidspiration’s symbol 
collection is bigger and better than ever with 3000+ symbols in the 
Symbol Library and the new Word Guide. The expanded collection 
provides greater visual coverage for Literacy, History and Science 
making Kidspiration a valuable cross-curricular tool. Pupils can also 
import symbols from other sources. 

Symbol Search
A new Symbol Search capability helps pupils search for and find just 
the right symbols to express their thoughts and ideas. Simply enter 
keywords into the box at the top of the Symbol palette and click the 
Find button. Kidspiration searches both the built-in symbol libraries 
and the Word Guide, and displays the search results in the palette.

Kidspiration® 3
 
Getting Started Guide
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Tools for Improving Literacy Skills 

Word Guide
Kidspiration now includes a Word Guide to further support 
vocabulary and reading comprehension as pupils create, organise 
and explain ideas and information visually. With easy access to 
nearly 13,000 words, the Word Guide includes sight vocabulary 
from the Fry’s Instant Word List, Dolch Word List and the NLS 
High Frequency Words. Word Guide also aligns with TESL 
vocabulary to support ELL and ESL pupils. Each entry includes 
definitions, recorded speech for pronunciation, synonyms and 
antonyms, syllabication, parts of speech and sample sentences. In 
addition, Word Guide pairs 1,400 words with images to enhance 
word recognition and comprehension.
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Enhanced Audio Support 
Longer recording time encourages pupils to express and document  
their ideas. Teachers enjoy greater flexibility when recording 
instructions and comments. For ESL and ELL learners, teachers 
can record instructions in native languages to enhance pupil 
understanding. With the Listen tool pupils can hear any text read 
aloud, strengthening word recognition and comprehension.

Tools for Building Conceptual Understanding in 
Maths
Now Kidspiration extends the proven principles of visual learning 
to mathematics with new visual maths tools. Combining the hands-
on learning power of manipulatives with all the added benefits of 
computer interactivity, Kidspiration’s maths tools help primary 
learners grasp essential and sometimes challenging maths concepts.

1HZ�0DWKV�9LHZ�DQG�LWV�¿YH�YLVXDO�0DWKV�7RROV
Functioning independently from Picture and Writing Views, the 
new Maths View has five distinctive visual maths tools, addressing 
curriculum focal points for ages 4-10, including number and 
operations (whole numbers, fractions and decimals), measurement, 
Algebra and two-dimensional geometry. 
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Accessible from the Maths Tool Starter:

• Kidspiration Colour Tiles™ are used to count and compare, 
explore properties of number and operations, and develop 
computation strategies. With Kidspiration Colour Tiles, pupils can 
solve area and perimetre problems, and model number patterns 
and the four basic operations.

 Colour tiles are squares with no quantity limit, so they work 
with numbers large and small. Tiles are easy to drag and drop, 
and can “snap” to each other or to an optional background grid, 
making it easy to create bar charts and build models and patterns. 
Kidspiration’s Maths SuperGrouper™ helps pupils count, sort 
and show operations visually. Teachers and pupils label Maths 
SuperGroupers as a conceptual building block for word problems. 

• Kidspiration Pattern Blocks™ are used to investigate the 
properties and attributes of shapes through composition and 
decomposition. Pupils produce patterns and tessellations, explore 
similarity and congruence, experiment with symmetry and 
represent fractions.

 Pattern blocks are moveable, stackable geometric shapes with 
side lengths and angles that “snap” together automatically, so it’s 
easy to make shapes and patterns. With the Rotate tool, pupils 
experiment with rotating shapes and explore how different shapes 
VWDFN�DQG�¿W�WRJHWKHU��8VLQJ�D�OLQH�IURP�WKH�0DWKV�SDOHWWH�GLVSOD\V�
and reinforces the concept of symmetry. Kidspiration’s Maths 
SuperGrouper adds additional meaning to counting and sorting 
activities.

• Kidspiration Base Ten Blocks™ help pupils to understand 
place value and strengthen number sense. They use Kidspiration 
Base Ten Blocks to count, compare, group, partition and create 
equivalent representations of whole numbers and decimals. 
Kidspiration Base Ten Blocks also introduces pupils to procedures 
for operations on multi-digit numbers.
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 Base ten blocks are units of ones, tens, hundreds and thousands. 
Pupils “make and break” blocks to compose and decompose 
multi-digit numbers. The Place Value Mat provides a visual 
structure for pupils to compare, order and generate equivalent 
representations of numbers. This visual framework helps pupils 
understand procedures such as carrying and borrowing. With the 
Kidspiration Maths SuperGrouper, pupils have a visual way to 
model operations on single and multi-digit numbers.

• Kidspiration Fraction Tiles™ are used to compare and order 
IUDFWLRQV�DQG�WR�XQGHUVWDQG�HTXLYDOHQW�IUDFWLRQV��3XSLOV�¿QG�
common denominators, translate between improper fractions and 
mixed numbers, and model basic operations with fractions.

 Fraction tiles are stackable, pre-sized rectangles in fractions from 
1/12 up to one whole. The tiles can “snap” together automatically 
to help pupils compare fraction values, build wholes and see the 
concept of equivalent fractions. A whole tray, representing 1 (or 
ZKROH��ZKHQ�¿OOHG��FDQ�EH�XVHG�DV�D�FRQWDLQHU�WR�KROG�IUDFWLRQ�
tiles. Fraction labels turn on and off to meet activity requirements. 

• Kidspiration Fraction Boxes™ are used to represent fractions  
visually to build a strong conceptual foundation for future work 
ZLWK�IUDFWLRQV��3XSLOV�FRPSDUH��RUGHU��VLPSOLI\�DQG�¿QG�HTXLYDOHQW�
fractions. They use Kidspiration Fraction Boxes to model basic 
operations with like and unlike denominators. Kidspiration 
Fraction Boxes also introduce pupils to improper fractions, mixed 
numbers and representing word problems.

 Fraction boxes are a dynamic fraction building tool using 
denominators up to 36. To build fractions, pupils set the number 
of parts and use colours and patterns to represent “parts of a 
whole” clearly. Pupils align boxes to model numbers greater 
than one and to compare fractions, change denominators with a 
VLPSOH�FOLFN�WR�¿QG�HTXLYDOHQW�IUDFWLRQV�DQG�LGHQWLI\�FRPPRQ�
denominators, and move tiles within the fraction box or to another 
box with a compatible denominator to show equivalency. With the 
Subtraction tool, learners represent subtraction operations visually 
and logically.
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The Right Functions Make the New Maths Tools 
Easy to Use
• Maths Text Box  

With the easy-to-use Maths Text Box, pupils document and express 
their new maths learning in words and numbers. Kidspiration 
includes basic maths symbols for fundamental operations, including 
the familiar +, -, x, ÷ and = symbols. Pupils click the More Tools 
EXWWRQ�WR�UHYHDO�DGGLWLRQDO�PDWKV�RSHUDWRUV��VXFK�DV����!����DQG�
more. The Maths Text Box includes structured frames for writing 
fractions, division problems and vertical maths notations. It’s a 
better way to combine maths, reading and writing in one visual 
maths environment.

• Cross-Out Stamp  
The Cross-Out Stamp gives pupils a visual indicator to use 
when they mark, take away or remove items.

• Step Workspace  
Showing your work is easy in the Step Workspace. Pupils use these 
sequential work areas to document their steps in problem solving. 
Teachers use the Step Workspace to model activities or show 
progression through an example problem.

• 11 basic colours and 50+ additional colours inspire pupils to use 
colour to explore maths concepts and demonstrate their grasp of 
maths fundamentals. 

• Multiple-level Undo and Redo functions let pupils explore “what 
if” scenarios and return to previous work as needed.

• Small/Medium/Large sizing options make it easy to view work.

• Multiple pages in a document streamline workspace management.
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Better Classroom Support with Additional 
Curriculum Content, Teacher Tools and Training
Kidspiration now includes more curriculum content, new teacher 
tools, training support and lesson plans in Literacy, Maths, Science 
and History, developed specifically for pupils ages 4-10, along with 
125+ activity templates. 
• Quick start activity templates give teachers classroom-ready 

resources and provide a launching pad to customise and create 
lessons for individual learners, small groups and the whole class.

• Learn-to-Use Tutorials provide a fast effective way to introduce  
teachers to visual learning with Kidspiration so they’re successful  
from the start.

• Teacher Resources Online provides additional lesson plans  
and activities. 

Additional New Functionality in Kidspiration 3
• Multi-level Undo and new Redo The Undo button is now  

capable of undoing up to 8 consecutive steps and a new Redo button 
will redo up to 8 steps.

• Support for higher resolution monitors, Windows® Vista®  and 
Macintosh® Leopard Kidspiration now supports higher resolution 
monitors with a larger visual workspace (optimised for 1024 x 768 
resolution). Kidspiration is also compatible with Windows Vista and 
Macintosh Leopard. 
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Installing Kidspiration
Kidspiration requires certain hardware and software components to 
run. Before installing, make sure your computer meets the following 
minimum requirements:

System requirements
Macintosh®

• Macintosh G3 300 MHz or faster
• OS X, version 10.2.8 or newer, Leopard compatible
• 192 MB minimum available RAM
• 75 MB minimum available hard drive; 250 MB for full install
• 800 x 600 (minimum), 1024 x 768 (recommended); 

Thousands of colours or higher
• CD-ROM drive (for installation only)
• Optional:

• Macintosh compatible printer
• Internet browser
• Microphone 
• Interactive electronic whiteboard 

Windows®

• Pentium II 266 MHz or faster
• Windows 98, ME, 2000, XP (including XP Tablet PC Edition) or Vista
• 128 MB minimum available RAM
• 75 MB minimum available hard drive; 250 MB for full install
• 800 x 600 (minimum), 1024 x 768 (recommended); 

16-bit colour or higher 
• CD-ROM drive (for installation only)
• Optional:

• Windows compatible printer
• Internet browser
• Soundcard and speakers
• Microphone
• Interactive electronic whiteboard
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About upgrading from an earlier version  
of Kidspiration
When you install Kidspiration 3, it does not overwrite any earlier 
version of Kidspiration installed on your computer. This enables you 
to keep custom activities and custom symbol libraries created in the 
earlier version of Kidspiration.
After you install Kidspiration 3, you can copy custom activities 
and symbol libraries from the earlier version of Kidspiration to the 
Kidspiration 3 IE folder. Be aware that if you choose to replace 
existing Kidspiration 3 files they will no longer be available in the 
program.
Copy symbol libraries from the earlier version of Kidspiration to 
a folder inside the Kidspiration Libraries folder. You can copy the 
libraries to an existing folder or to a folder you create.
Copy activities from the earlier version of Kidspiration to the 
Kidspiration Activities folder inside the Kidspiration 3 IE folder. After 
you copy the activities and libraries you want to keep, you can remove 
the earlier version of Kidspiration. 
Any files you created using Kidspiration 1 and later can be opened by 
Kidspiration 3, but you may lose some elements (such as symbols) 
and formatting, so be sure to check your documents carefully.

Macintosh installation
1. Close all programs, including screen saver and anti-virus programs.
2. Insert the Kidspiration CD-ROM into your CD-ROM drive.
 –or–
 For electronic downloads, after downloading  

Kidspiration3IE_mac.zip��GRXEOH�FOLFN�WKH�¿OH�WR�GHFRPSUHVV�WKH�
download. Locate the Kidspiration 3IE.dmg�¿OH�DQG�GRXEOH�FOLFN�
it to mount the disc image. A folder should automatically open. 
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Additionally, a Kidspiration 3 IE CD icon will appear on your 
desktop and in the Finder.

3. Drag the Kidspiration 3 IE folder to your Applications folder.

4. When you run Kidspiration, the Personalise Kidspiration 
dialogue appears.

 Enter your name and/or organisation, and your serial number or 
activation code. Click OK.

 Note: If you purchased a single licence, your serial number can 
be found on your CD-ROM sleeve. If you purchased a volume 
licence, your serial number can be found on your volume licence 
agreement. If you downloaded Kidspiration electronically, you will 
receive an activation code at the end of the purchase process, as 
well as in an email. The serial number or activation code identifies 
your copy of Kidspiration and is required to personalise your 
Kidspiration application. 

Windows installation
1. Close all programs including screen saver and anti-virus programs.
2. Insert the Kidspiration CD-ROM into your CD-ROM drive.
3. Click the Install button to install Kidspiration.
 –or–

 For electronic downloads, after downloading Kidspiration3IE_
win.exe, double-click the file to decompress the download. A 
folder named Kidspiration 3 IE will automatically open. Locate 
and run the file named Kidspiration 3 IE Installer.exe.

4. Select Full Install or Minimum Install:

• Select Full Install to install the full Kidspiration program, 
including symbols, activities, examples and the Help system.
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 –or–
• Select Minimum Install to install the Kidspiration program and 

activities without the Word Guide sound recordings and images 
as well as Learn-to-Use Tutorials and Lesson Plans. Select this 
option if you do not want to install all Kidspiration options.

5. Follow the instructions on your screen to complete the installation 
process. 

  A message appears when installation is complete.

6. Kidspiration starts automatically and the Personalise Kidspiration 
dialogue appears.

 Enter your name and/or organisation, and your serial number or 
activation code. Click OK.

 Note: If you purchased a single licence, your serial number can 
be found on your CD-ROM sleeve. If you purchased a volume 
licence, your serial number can be found on your volume licence 
agreement. If you downloaded Kidspiration electronically, you will 
receive an activation code at the end of the purchase process, as 
well as in an email. The serial number or activation code identifies 
your copy of Kidspiration and is required to personalise your 
Kidspiration application.  

Network installation
Refer to the network installation instructions provided with your 
volume licence. Volume licences are available from Inspiration 
Software®, Inc. For more information, call 503-297-3004.
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Registering Kidspiration
If you purchased a single copy of Kidspiration, you will need to  
register online.
To register online, do so after installing when the application is first run, 
or click Register Online on the Teacher menu after you personalise 
Kidspiration. Your browser starts and opens Kidspiration’s online 
registration form. Follow the on-screen instructions. (Note: You must 
have an Internet connexion and web browser installed to register online.) 
When you register, you’re entitled to special benefits from Inspiration 
Software, Inc. As a registered customer, you receive:

• Free telephone, fax and email technical support

• Substantial discounts on Kidspiration upgrades

• Tips on using Kidspiration

• Information about new products and product updates

• Flashes, the Inspiration Software®, Inc. e-newsletter

About Kidspiration customer service
Inspiration Software®, Inc. is committed to assisting our customers. If 
you have comments, questions or need assistance while working with 
Kidspiration, please email techsupport@inspiration.com. You can 
also connect to Kidspiration Technical Support while you are using 
Kidspiration. On the Teacher menu, point to Teacher Resources 

Online, and then click Technical Support. 
Inspiration Software, Inc. provides free customer service and technical 
support for registered users. Be sure to register so you can take advantage 
of our support services. 
When you contact us, please provide your serial number. Our support 
services are open Monday through Friday from 8 a.m. to 5 p.m. 
Pacific Time. 
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Viewing and printing Kidspiration 
documentation
This Getting Started Guide and the Learn-to-Use Tutorials are 
available in the form of PDF files. To view or print these materials, 
you need Adobe® Reader® installed on your computer. If your 
computer does not have Adobe Reader, you can download a free copy 
from Adobe at www.adobe.com.

To view or print Kidspiration documentation:
1. Select Kidspiration Documentation from the Help menu.
2. Here you will find the following PDFs:

Getting Started.pdf Includes installation 
instructions and Learning 
Kidspiration Tutorials.

Learn-to-Use Tutorials Designed to help you learn to 
work in Picture View, Writing 
View and each of Maths 
View’s Maths Tools.

3. Double-click a PDF to view or print it.

Removing Kidspiration

Macintosh
• Drag the Kidspiration 3 IE folder to the Trash, and then empty  

the Trash.

Windows
1. Click the Start button, point to Settings, and then click Control 

Panel.
2. Double-click Add/Remove Programs.
3. Click Kidspiration 3 IE in the list, and then click Add/Remove.
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Starting and closing Kidspiration

To start Kidspiration:
• Open the Kidspiration 3 IE folder and double-click the 

Kidspiration 3 IE icon (Macintosh).

 

–or– 

• Click the Start button, point to Programs, and then click 
Kidspiration 3 IE (Windows).

To close Kidspiration:
• On the File menu, click Quit (Macintosh) or Exit (Windows).

Starting a new Kidspiration project
1. Start Kidspiration.
 –or– 
 To return to the Kidspiration Starter from an open project, click the 

Go to Starter button.
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2. Do one of the following:

• To start with a new diagram, click the Picture View button.

• To start with a new writing project, click the Writing View 
button.

• To start with a new maths project, click the Maths View button.

Opening an activity
1. Start Kidspiration.
 –or–

 On the File menu, click New to return to the Kidspiration Starter.

2. Under Activities, click a category, for example “Science.”
 

3. Click the activity you want to open, and then click OK.
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 Note: You cannot open a Kidspiration 3 activity using an earlier 
version of Kidspiration. To use a Kidspiration 3 activity with 
an earlier version of Kidspiration, first open the activity in 
Kidspiration 3, and save it in Kidspiration 2 format.

Opening an existing project 

1. On the File menu, click Open.
 –or–

  From the Kidspiration Starter, click the Open a File button.
 
 

2. Open the folder where the file is located.

3. In the list box, click the file you want to open, and then click OK.

Adding your name to a project
You can add a pupil name to a project. The name is displayed in the 
following locations:
• In the title bar of the document.

�� $V�WKH�VXJJHVWHG�¿OH�QDPH�ZKHQ�WKH�SURMHFW�LV�VDYHG�WKH�¿UVW�WLPH�� 
(You can change the suggested name if you want.)

• At the top of every page when you print.

To add your name to a project:
1. Click the Pupil Name button. 
2. Type your name in the box  

where indicated.
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3. To choose where you want your name to appear on the page, select 
Left, Centre or Right.

 A preview of how your name will appear on the page is displayed 
in the box on the right side of the dialogue box.

4. Click OK.

Saving a project

To save a project:
1. On the File menu, click Save to save the latest changes to your 

work.
 The first time you save, select the folder where you want to save 

the project and type a name for the project.
 If you have entered a pupil name for the project using the Pupil 

Name tool, the pupil name is the suggested file name. You can 
change the suggested name if you want.

2. In the Save dialogue box, click Save.

 Note: Kidspiration 3 has an autosave feature, so your work will be 
saved to a temporary folder every 3 minutes. If the application or 
your computer quits unexpectedly, you will be able to recover the 
file when you restart Kidspiration.

Saving a project under a different name
1. On the File menu, click Save As.
2. Select the folder where you want to save the project.

3. Type a new name for the project, and then click Save.
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About Picture View
In Picture View, Kidspiration gives you many different tools to map, 
organise and display ideas visually. 

The buttons on the Picture toolbar provide easy access to the key features 
of the program. Point at a button on the toolbar to see and hear a brief 
description of the button’s purpose. Click a button to carry out the function. 
The Symbol palette includes over 3,000 symbols you can use to show 
your ideas visually. You can browse the more than 80 libraries or perform 
a keyword search to find just the right symbol. Point at a symbol to see a 
magnified preview. To place a symbol on your diagram, drag the symbol 
from the Symbol palette. 
The Main Idea symbol provides a starting point for your diagram. Type 
text in the Main Idea symbol or change it to a symbol that represents your 
idea. 
Use the tools on the Formatting toolbar to change the look of the text, 
symbols and links on your diagram. 
To return to the Kidspiration Starter at any time, click the Go to Starter 
button. You will be prompted to save the open project.

Formatting toolbar

Main Idea Symbol
Symbol Palette

Go to Starter Picture toolbar
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Picture toolbar buttons
Click this button … ...to do this

Go to Writing View

Go to Writing View.

Add Symbol

Add a linked or unconnected symbol to your 
diagram.

Link Symbols

Link symbols on your diagram.  

SuperGrouper

Add, create or change a SuperGrouper® shape.

Clear

Clear the current selection (symbol, link, 
SuperGrouper shape or text) from your 
diagram.

Undo

Undo up to the last eight changes you made.

Redo

Redo up to the last eight changes you used the 
Undo button to undo.

Listen

Turn on the Listen tool. Click a symbol, link 
or a SuperGrouper shape to hear the computer 
read the text in the selection.

Pupil Name

Add pupil name to appear in the title bar of the 
document and at the top of every printed page.

Symbol Maker

Draw your own symbol using the Symbol 
Maker tool.

Word Guide

Look up words and learn their parts of speech, 
definitions, synonyms and more.
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The Symbol palette
Kidspiration offers more than 3,000 colourful symbols, including 
several hundred photographic images and animated symbols. The 
symbols are organised into categories and libraries.
To choose a symbol on the Symbol palette:
1. Click the Pick Library button , and then click the symbol 

library you want in the list. Point to a library in the list to see a 
preview of the library on the Symbol palette.

2. Click the Previous Library or Next Library buttons  to 
move between the symbol libraries.

To search the symbol libraries: 
Type a word or words describing the symbol you are looking for in the 
box at the top of the palette, then click the Find button.

Click Find to 
begin search. 

Enter search 
words here.

To see a preview of a 
symbol, point to it.

Click to see the 
next library.

Click to see 
the previous 
library.

Click to select a library.



26

Kidspiration® 3
 
Getting Started Guide

Formatting toolbar in Picture View
When you change the look of a symbol or link, the change applies not 
only to that symbol, but also to new symbols and links that you add 
from that point on. For example, if you select a basic symbol shape, 
such as an oval or rectangle, and you change its colours to green and 
black, any basic symbols you add to your diagram will also be green 
and black. 

Click this button … ...to do this

Change the font of the selected text, symbol, 
SuperGrouper shape or link. 

Change the text size of the selected text, symbol, 
SuperGrouper shape or link.

Apply bold formatting to words in the selected 
text, symbol, SuperGrouper shape or link.

Apply italic formatting to the words in the 
selected text, symbol, SuperGrouper shape or 
link.
Underline the words in the selected text, symbol, 
SuperGrouper shape or link.

Change the colour of the words in the selected 
symbol, SuperGrouper shape or link.

Change the arrowhead style for the selected link.

Change the line width of the selected symbol, 
SuperGrouper shape or link. 

Hide/show symbol captions.

Change the colours of the selected symbol. 
Note: The colours that appear on the Formatting 
toolbar are the colours in the selected symbol.
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About Writing View
If you started your project in Picture View, your work is transferred 
when you switch views. In Writing View, Kidspiration gives you many 
different tools for organising and expanding your ideas in writing. 

The buttons on the Writing toolbar provide easy access to the key 
Kidspiration features. Point at a button on the toolbar to see and hear 
a brief description of the button’s purpose. Click a button to carry out 
the function. 

If you are beginning a new project in Writing View, the Main Idea 
provides a starting point for your writing. Type an idea into the Main 
Idea and go from there.

Use the tools on the Formatting toolbar to change the look of the text  
and the page. 

To return to the Kidspiration Starter at any time, click the Go to 
Starter button. You will be prompted to save the open project.

Main IdeaWriting toolbar

Go to Starter

Formatting toolbar
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Writing toolbar buttons

Click this button... ...to do this

Go to Picture View

Go to Picture View.

Add Idea

Add a new idea to your project.

Move Left

Move the selected idea up one level in the 
hierarchy.

Move Right

Move the selected idea down one level in the 
hierarchy.

Clear

Clear the selected text or idea from your project.

Undo

Undo up to the last eight changes you made.

Redo

Redo up to the last eight changes you used the 
Undo button to undo.

Listen

Turn on the Listen tool. Click an idea to hear the 
computer read it.

Pupil Name

Add pupil name to appear in the title bar of the 
document and at the top of every printed page.

Publish

Transfer your writing project to a word processor. 
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Formatting toolbar in Writing View
When you change the look of an idea, the change applies to new ideas 
you add to your writing project. For example, if you select an idea 
and change its text colour to green, any ideas you add to your writing 
project will also have green text. 
New ideas are not affected by changes to selected text within an idea.

Click this button ...to do this

Change the font of the selected text or idea. 

Change the text size of the selected text or idea.

Apply bold formatting to the words in the 
selected text, symbol, SuperGrouper shape or 
link.

Apply italic formatting to the words in the selected 
text, symbol, SuperGrouper shape or link.

Underline the words in the selected text, symbol, 
SuperGrouper shape or link.

Change the colour of the words in the selected 
symbol, SuperGrouper shape or link.

Change the prefix style.

Show or hide the lined paper. 
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About Maths View
Designed to build conceptual understanding in maths, Maths View 
functions independently from Picture View and Writing View, and is 
comprised of five distinct Maths Tools: Kidspiration Colour Tiles™, 
Kidspiration Pattern Blocks™, Kidspiration Base Ten Blocks™, 
Kidspiration Fraction Tiles™ and Kidspiration Fraction Boxes™. 
To choose a Maths Tool, click the Maths View button on the 
Kidspiration Starter, and make your choice on the Maths Tool 
Starter. You’ll notice a sixth option called the Free Workspace, where 
you can create activities in which pupils will need to choose the Maths 
Tool most appropriate for their work. 
Maths View allows for the creation of multiple pages of work within a 
single document, giving pupils an opportunity to show their thinking 
using one or more tools, and to describe and document multiple ways 
of solving a problem. An alternative is to select Use Steps on the 
Maths Tool Starter before you choose a tool. When this option is 
selected, a document will be broken up by multiple steps, allowing 
progression of work to be represented using a single tool. 
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After choosing a Maths Tool, the toolbars and Maths palette provide 
easy access to the Kidspiration Maths View features. 

Point at a button on the Maths toolbar at the top of the workspace to 
see and hear a brief description of the button’s purpose. Click a button 
to carry out the function. 

Use the Maths palette to the left of the workspace to access the 
manipulatives for each Maths Tool, as well as to add text and organise 
your project. The options available in the Maths palette are particular 
to each Maths Tool. 

Use the tools on the Bottom toolbar to change the look of 
manipulatives and text in your project. The options available in the 
Bottom toolbar are particular to each Maths Tool. At any time, you can 
return to the Kidspiration Starter from a maths project by clicking the 
Go to Starter button.

You will be prompted to save the open project.

Maths toolbar buttons
Each Maths Tool contains the following buttons on the Maths toolbar:

Click this button... to do this

 Maths Tools

Go to the Maths Tools dialogue and choose a 
different Maths Tool if no maths manipulatives are 
on the workspace.

Clear 

Clear the currently selected object or objects from 
your workspace.
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Undo

Undo up to the last eight changes you made.

Redo

Redo up to the last eight changes you made using the 
Undo button.

Pupil Name

Add pupil name to appear in the title bar of the 
document and at the top of every printed page.

Go To Page

Click Go To Page to go to the Choose Page dialogue 
where you can add, preview, navigate to and delete 
pages. (Not available when using steps.)

Go to Previous 
Page

Go to the previous page in your multiple page 
document. (Not available when using steps.)

Go to Next Page

Go to the next page in your multiple page document. 
(Not available when using steps.)

Add Step to End

Add a new step to the end of your document. (Only 
available in the Step Workspace. Select Use Steps on 
the Maths Tool Starter.)

Delete Step from 
End

Delete a step from the end of your document. (Only 
available in the Step Workspace. Select Use Steps on 
the Maths Tool Starter.)

Go to Previous Step

Go to the previous step in your document. (Only 
available in the Step Workspace. Select Use Steps on 
the Maths Tool Starter.)

Go to Next Step

Go to the next step in your document. (Only 
available in the Step Workspace. Select Use Steps on 
the Maths Tool Starter.)
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Maths palette in Maths View
The Maths palette appears to the left of the workspace in each Maths Tool. 
Each Maths Tool’s palette contains a Maths Text Box and a line. The other 
elements available in the Maths palette are particular to each Maths Tool.

The Kidspiration Colour Tiles Maths palette contains a Maths Text 
Box, a line, four starter colour tiles, and both a rectangular and a 
circular Maths SuperGrouper™.
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The Kidspiration Pattern Blocks Maths palette contains a Maths 
Text Box, a line, six geometric shapes, and both a rectangular and a 
circular Maths SuperGrouper.
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The Kidspiration Base Ten Blocks Maths palette contains a Maths 
Text Box, a line, units representing one, ten, one hundred and one 
thousand, and both a rectangular and a circular Maths SuperGrouper.



36

Kidspiration® 3
 
Getting Started Guide

The Kidspiration Fraction Tiles Maths palette contains a Maths 
Text Box, a line, fraction tiles and a whole tray.
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The Kidspiration Fraction Boxes Maths palette contains a Maths 
Text Box, a line and a fraction box.

Choose the elements you want to work with by clicking them or by 
dragging them onto the workspace. 
To create multiple identical items on the workspace, click that item on 
the Maths palette multiple successive times.

Bottom toolbars in Maths View
There are two Bottom toolbars in each Maths Tool. One is for working 
with Maths Text Boxes and the other is for working with the maths 
manipulatives in each tool, and is therefore different for each tool.
When working with Maths Text Boxes in the Maths View workspace, 
the full Bottom toolbar looks like this:

 Note: When working with Maths Text Boxes, you will need to 
click the arrow to the right of the Open Maths Frame button

in order to see all of the Bottom toolbar. 
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Kidspiration Colour Tiles Bottom toolbar
When working with colour tiles, lines or Maths SuperGroupers in the 
Kidspiration Colour Tiles workspace, the Bottom toolbar looks like 
this:

Kidspiration Pattern Blocks Bottom toolbar
When working with shapes, lines or Maths SuperGroupers in the 
Kidspiration Pattern Blocks workspace, the Bottom toolbar looks like 
this:

Kidspiration Base Ten Blocks Bottom toolbar
When working with units, rods, flats, blocks, lines or Maths 
SuperGroupers in the Kidspiration Base Ten Blocks workspace, the 
Bottom toolbar looks like this:
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Kidspiration Fraction Tiles Bottom toolbar

When working with tiles, lines or a whole tray in the Kidspiration 
Fraction Tiles workspace, the Bottom toolbar looks like this:

Kidspiration Fraction Boxes Bottom toolbar
When working with fraction boxes, tiles or lines in the Kidspiration 
Fraction Boxes workspace, the Bottom toolbar looks like this:
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Chapter 3: Learning Kidspiration®, 
Picture and Writing View Tutorials
This section of the Getting Started Guide is comprised of four 
tutorials that introduce basic Kidspiration diagram and writing 
tools. It takes about 30 minutes to complete these four tutorials.
Kidspiration is used the same way as most Mac OS® and 
Windows® programs. For example, as you work, you use the 
mouse to drag objects and to select text. You also click and double-
click, and enter information using the keyboard. If you are not 
familiar with doing these things, take a moment now and refer to 
the user’s guide that came with your computer.

Conventions we used
When we refer to program functions in instructions, they appear in  
bold. For example, “Click the Picture View button on the 
Kidspiration Starter.” When you are asked to enter specific text, 
the text you type appears in bold as well. For example, All About 
Me. When referring to a symbol or name you already entered, it 
appears in italics, like All About Me.

How we organised the tutorials
In these four Kidspiration tutorials, you follow a series of step-
by-step instructions to create a diagram, which is a simple visual 
representation of an idea. You also work with your ideas in writing.
The tutorials are designed to be completed in order, but you do not 
have to do them all at one time. Each tutorial introduces you to 
several of the unique functions in Kidspiration. When you finish 
the tutorials, you will be ready to create diagrams, writing projects 
and activities on your own.
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Tutorial One: Creating a diagram in  
Picture View
In this tutorial you will create a diagram called “All About Me” using 
symbols, words and links. You will learn to do the following:
• Start a new diagram in Kidspiration

• Add your name and save your work

• Work with symbols

• Fix a mistake

• Change the look of text using font, text size and colour

• Close a project and return to the Kidspiration Starter
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Starting Kidspiration

To start Kidspiration on a Macintosh:
• Open the Kidspiration 3 IE folder and double-click the 

Kidspiration 3 IE icon.

 The Kidspiration Starter opens.

To start Kidspiration in Windows:
• Click the Start button, point to Programs and click Kidspiration 3 IE.

 The Kidspiration Starter opens.

The Kidspiration Starter is the place where you start new projects, 
open existing projects, and use the many different Kidspiration 
activities. You will begin by starting a new diagram.

Starting a new diagram

1. To start a new diagram, click the Picture View button.

 A new document opens with a Main Idea symbol. The Main Idea 
symbol provides a starting point for your work.
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2. In the Main Idea symbol, type All About Me. 

Adding your name to a project

1. On the Picture toolbar, click the Pupil Name button.

2. Type your name in the box where indicated.
 For the examples in this tutorial we will use the name “Glenna.”
3. To choose where you want the name to appear on the page, select 

Left, Centre or Right.
 A preview of how the name will appear on the page is displayed in 

the box on the right side of the dialogue box.

4. Click OK.
 The pupil name appears in the title bar of the document.

Saving your work

1. On the File menu, click Save.
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2. In the folder list, click the folder where you want to save the 
project.

3. Type a name for the project, and then click Save.
 Kidspiration suggests the name “Glenna” based on the pupil name, 

but you can use a different name.

Adding symbols to your diagram
There are many different ways to add symbols in Picture View. An 
easy way to add a linked symbol is the Add Symbol tool.
1. Click the All About Me symbol to select it.

2. To add two symbols that are connected to the All About Me 
symbol, click the Add Symbol button  two times.

3. Select the left symbol, and then type the word Home.

 Select the right symbol, and then type the word School.
 Now the diagram looks like this:
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Using the Symbol palette
Now you will use the Symbol palette to add more symbols to the 
diagram. The Symbol palette has over 3,000 symbols that you can use 
to show your ideas. Here is the Symbol palette:

1. On the Symbol palette, click the Next Library button  one 
time. Drag your favourite pet symbol onto the diagram.

2. Click the Pick Library button .

3. Scroll down the list to School, and then click Classroom.
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4. Drag the books symbol onto the diagram. 
 Adjust the position of the symbols so the diagram looks like this:

Performing a symbol search
If you are looking for a specific symbol, you can perform a symbol 
search. 

1.  Type heart into the search box at the top of the Symbol palette 
and click the Find button.

2.  Drag the heart symbol onto the diagram, then type 2 sisters.
 Adjust the heart symbol position so the diagram looks like this:
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Showing symbol captions
To add flexibility to lessons, you can show or hide the symbol 
captions.

• To show or hide the symbol captions, click the Show/Hide 
Captions button  on the Formatting toolbar.

 The captions appear below all the symbols in the diagram.

Drawing a symbol using the Symbol Maker tool
The Kidspiration Symbol Maker enables you to create your own 
symbols using draw and paint tools. You can draw lines and shapes, 
then fill the shapes with different colours. The Stamp tool is an easy 
way to add images, numbers and letters to your drawing. 

Opening the Symbol Maker
1. Select the All About Me symbol.

2. On the Picture toolbar, click the Symbol Maker button.

The Kidspiration Symbol Maker opens.

• Use the tools on the Tool palette to draw lines and shapes and edit 
the drawing.

• Use the Nib palette�WR�GH¿QH�WKH�VKDSH�DQG�ZLGWK�RI�WKH�OLQH�IRU�WKH�
selected tool.

• Use the Colour palette to choose a colour for the selected tool.
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• Draw on the canvas in the centre of the dialogue box.

Tips before you begin drawing
There are some special tools on the Tool palette you may find useful 
as you begin drawing.
• If you make a mistake and you want to undo what you just did, click 

the Undo tool.

• If you want to clear the canvas and start over, click the Clear All 
tool.
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• If you want to erase part of the drawing, click the Rubber tool,  
and then drag the pointer over the area you want to erase. You can 
click a nib on the Nib palette�WR�GH¿QH�WKH�VKDSH�DQG�ZLGWK�RI�WKH�
rubber.

 

Drawing the face, including eyes, nose and mouth
1. On the Tool palette, click the Paintbrush button.

2. On the canvas, drag the Paintbrush to draw a face that looks 
something like this:

Filling the face and shirt with colour
1. On the Tool palette, click the Paint Bucket button.
 

2. On the Colour palette, click a colour for the face.
3. On the canvas, click inside the face. 
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4. On the Colour palette, click a colour for the shirt.
5. On the canvas, click inside the shirt. 
 Now the drawing looks something like this:

Adding hair to the top of the head
1. On the Tool palette, click the Spray Can button.
 

2. To increase the width of the Spray Can pattern, click a larger nib 
on the Nib palette.

 

3. On the Colour palette, click a colour for the hair. 
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4. On the canvas, drag the Spray Can to draw hair that looks 
something like this:

Adding glasses to the face using the Stamp tool
1. On the Tool palette, click the Stamp tool.
 

2. On the Stamp palette, use the Up or Down arrow to locate the 
glasses. Click the glasses stamp.

3. On the Colour palette, click a colour for the glasses. 

4. To change the size of the glasses, click one of the Size buttons.
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5. Roll the pointer over the face to see a preview of the glasses. 
6. Position the glasses where you want them on the face, and then 

click to add the glasses to the drawing.
 Now the drawing looks something like this:

Adding the drawing to your diagram
• To add the drawing to the diagram, click the Done button.

The All About Me symbol is replaced with the symbol you created.

Moving symbols
In Kidspiration you can always move symbols by dragging them. 
When you do, any links automatically adjust. Drag the All About Me 
symbol up so your diagram looks like the one below:
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Changing the look of symbols using colour
Colour is great for customising the look of symbols. You can change 
the colours of two-colour symbols and multicolour symbols. 
1. Select the Home symbol.
 The Symbol Colours tool appears on the Formatting toolbar. 

2. On the Symbol Colours tool, click the Fill Colour button, and 
then click a new colour on the palette.

3. Now change the line colour of the symbol. On the Symbol 
Colours tool, click the Line Colour button, and then click a new 
colour on the palette.

4. Next change the colours of the All About Me symbol. Select the All 
About Me symbol.

 The Symbol Colours tool appears on the Formatting toolbar. 
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5. On the Symbol Colours tool, click the shirt colour and then click a 
new colour on the palette.

6. On the Symbol Colours tool, click the glasses colour and then 
click a new colour on the palette.

Connecting symbols using links
Now it is time to add links. The Link tool is used to demonstrate 
comprehension and show relationships. 
1. Select the Home symbol. This is the symbol where the link will 

start.

2. On the Picture toolbar, click the Link button.
 

The cursor now looks like this .
3. Click the 2 sisters symbol to complete the link.
4. Follow these steps to link the remaining symbols.
 Your diagram should look like this:
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Removing part of the diagram
Here is a quick way to remove part of your diagram.
1. Select the books symbol.

2. On the Picture toolbar, click the Clear button.

 

Fixing a mistake
The Undo tool is a quick way to fix something you did not mean to do.

• To undo what you just did, click the Undo button.

The books symbol reappears on the diagram.

Changing the look of text
You can customise text using font, text size and colour.
1. Select the All About Me symbol.
2. Click inside the symbol’s text area, and then select the word Me.

3. On the Formatting toolbar, click in the Font box, and then click a 
new font in the list.



57

Chapter 3: Learning Kidspiration®, Picture and Writing View Tutorials

4. On the Formatting toolbar, click the Text Colour button ,  
and then click a new colour on the palette:

5. Press the Escape key to end text editing and select the symbol.
 Now the text looks like this: 

Closing your project and returning to the 
Kidspiration Starter
Congratulations! You have completed Tutorial One: Creating a 
diagram in Picture View. Close this lesson and continue to Tutorial 
Two: Expanding ideas in Writing View.
To close your project and return to the Kidspiration Starter, click the 
Go to Starter button.
 

When you return to the Kidspiration Starter, you are prompted to save 
the open project. Click Yes to save the project. 



58

Kidspiration® 3
 
Getting Started Guide

Tutorial Two: Working with ideas in 
Writing View
In this tutorial you will open the diagram you created in the previous 
tutorial and work with it in Writing View. You will learn to do the 
following:
• Open a project in Writing View

• Work with ideas

• Look up a word in the Word Guide

• Change the look of text

�� +LGH�WKH�OLQHG�SDSHU�DQG�FKDQJH�WKH�SUH¿[�VW\OH

• Save your project, print it and publish it in a word processor
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Opening a project

1. On the File menu, choose Open.
 –or–

 From the Kidspiration Starter, click the Open a File button.
2. Open the folder where you saved the file from the previous lesson.

3. In the list box, click the file you saved from the previous lesson, 
and then click Open.

Switching to Writing View
While you have been working in Picture View, Kidspiration has been 
building a written project using the ideas in your diagram.

• To view your ideas in Writing View, click the Go to Writing View 
button.
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In Writing View, the ideas in your diagram are organised from top to 
bottom, with your main idea—All About Me—at the top. Each idea 
appears on its own piece of lined paper. Symbols at the beginning of 
each idea help emerging readers develop word-meaning skills.

Adding an idea
You can add a new idea in Writing View as easily as you added a new 
symbol in Picture View.

1. On the Writing toolbar, click the Add Idea button .

2. Type the word Dad in the new idea.
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This is what your project looks like now:

Changing the level of an idea
There are many ways to organise ideas in Writing View. The Move 
Left and Move Right buttons on the Writing toolbar change the level 
of an idea in the hierarchy. 

• On the Picture toolbar, click the Move Right button  two 
times.

 Now the outline looks like this:
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Changing the order of ideas
You can also change the order of ideas by dragging and dropping. 
1. Select the Home idea.
2. Point to the left or top edge of the idea. When the appears, 

drag the idea above the School idea.
 While you drag, the idea remains in the original position until 

you release the mouse button. You can see where the idea’s new 
location will be by watching the black line as you drag. When the 
line is at the level you want the idea to appear, release the mouse 
button.
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Now the project looks like this:

Looking up a word in the Word Guide

You can look up words in the Word Guide in both Picture View and 
:ULWLQJ�9LHZ��7KH�:RUG�*XLGH�FRQWDLQV�GH¿QLWLRQV��SDUWV�RI�VSHHFK��
synonyms and more.

1. Click somewhere in the Home idea and select the word Home. 

2. Click the Word Guide button on the Picture toolbar.
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 The Word Guide dialogue box will open. 

 

3. Click the Listen buttons  to hear the word and other text read 
aloud.

4. Click the 1H[W�'H¿QLWLRQ button  once to see the next results 
IRU�WKH�ZRUG�+RPH��1RWLFH�WKH�QHZ�GH¿QLWLRQ�DQG�DGGLWLRQDO�
synonyms.

5. Click the More Detail button . Notice the addition 
RI�DQWRQ\PV��ZRUG�LQÀHFWLRQV�DQG�V\OODELFDWLRQ��DV�ZHOO�DV�D�
pronunciation key. 

6. Click Cabin in the list of synonyms and antonyms and the Word 
Guide will automatically look up this word for you. Notice the 
drawing of the cabin associated with the word Cabin.

7. Click the Close button to close the Word Guide.
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Adding details to an idea
Notes are a great way to add more information about an idea. You can 
add as many lines of notes as you wish.
• The notes area is below the top line of the idea. Click in the notes 

area of the All About Me idea, and then type by Glenna.

You can type details in the notes area of each idea.

Changing the look of text
The tools on the Formatting toolbar are used to customise the look of 
text in ideas or notes.
1. Click in the notes area of the All About Me idea, and then select the 

words by Glenna.

2. To apply bold formatting to the selected words, click the Bold

 button on the Formatting toolbar.
3. Select the All About Me idea. 
 Now the text by Glenna is bold.
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Hiding the lined paper
Turning off the lined paper gives a writing project the look of a more 
traditional outline.

• To turn off the lined paper, click the Hide Paper  
button  on the Formatting toolbar.

 Now the project looks like this:
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&KDQJLQJ�WKH�SUH¿[�VW\OH
As pupils become more advanced, Kidspiration can be used as a full-
fledged outliner with a range of prefix options.

�� 7R�FKDQJH�WKH�SUH¿[��FOLFN�WKH�3UH¿[ button on the 
Formatting�WRROEDU�XQWLO�\RX�VHH�WKH�SUH¿[�WKDW�\RX�ZDQW��

 Now the project looks something like this:

Saving your work
Remember to save your work!

On the File menu, click Save.
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Printing your work
You can print your work in Kidspiration.

1. On the File menu, click Print.

2. In the Print dialogue box, click Print.

Publishing your work in a word processor

The Publish tool transfers a writing project to Microsoft® Word,  
Appleworks® or Scholastic Keys® (Macintosh) or to Microsoft Word 
and Scholastic Keys (Windows), where you can put finishing touches 
on your composition. 
1. On the Writing toolbar, click the Publish button.

2. If necessary, select Microsoft Word, Appleworks or Scholastic 
Keys, and then click OK.

 If your computer has only one of these word processing programs, 
Kidspiration automatically opens the available program.

 The selected word processor opens with a new document 
containing the information in your Kidspiration project.

 A graphic of the diagram in Picture View appears, followed by the 
text, including topics and notes.

 You can control how a document is published—for example, you 
can transfer only the notes in a project—using the Publish Options 
on the Teacher menu.

3. On the File menu, click Close to close the word processing 
document.
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Closing your project and returning to the  
Kidspiration Starter
Congratulations! You have completed Tutorial Two: Working with 
ideas in Writing View. Close this project and continue to Tutorial 
Three: Categorising ideas using the SuperGrouper tool.

• To close your project and return to the Kidspiration Starter,  
click the Go to Starter button.

 When you return to the Kidspiration Starter, you are prompted to 
save the open project. Click Yes to save the project.
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Tutorial Three: Categorising ideas using 
the SuperGrouper® tool
In Kidspiration there are two basic ways to organise ideas in Picture 
View: links and SuperGrouper categories. You have already seen how 
links work. Now you will learn about the SuperGrouper tool.
Categorising and sorting are important skills for pupils ages 4-10, and the 
SuperGrouper tool makes these activities easy and fun. In many cases, 
teachers will find it most effective to create the SuperGrouper categories 
as part of an activity and let pupils simply sort ideas into their respective 
categories. 
In this lesson, you will learn to do the following:
• Add a SuperGrouper category

• Create a new SuperGrouper shape

• Add a title to a SuperGrouper category

• Change the colours of a SuperGrouper category

• Add and remove symbols from a SuperGrouper category

• View SuperGrouper categories in Writing View
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Starting a new diagram
If you have not started Kidspiration, do so now.

• In the Kidspiration Starter, click the Picture View button.

A new diagram opens with the Main Idea symbol selected.

Saving your work
The first time you save, you type a name for your project.

On the File menu, click Save.
In the folder list, click the folder where you want to save the project.

Type SuperGrouper Lesson for the name of the project, and then 
click Save.
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Adding a SuperGrouper category
There are several ways to add SuperGrouper categories to your 
project.

1. On the Picture toolbar, click the SuperGrouper button.

2. On the SuperGrouper menu, click the rectangle SuperGrouper 
shape to add it to your diagram.

 The new SuperGrouper category automatically contains any 
selected symbols—in this example, the Main Idea symbol on the 
diagram.
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Creating a new SuperGrouper shape
Any symbol can be transformed into a SuperGrouper shape.

1. Click the Previous Library button on the Symbol palette 
once.

2. Drag the basket symbol onto the diagram and place it to the left of  
the rectangle.

3. On the Picture toolbar, click the SuperGrouper button, and then 
click Create SuperGrouper.
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 The basket symbol becomes a SuperGrouper category with a title 
area at the top. The symbol handles become stars and the new 
SuperGrouper is larger.

 If necessary, drag the SuperGrouper shapes to adjust their location. 
Now the diagram looks like this:

Adding a title to a SuperGrouper category
SuperGrouper labels appear at the top of each shape.

1. Select the basket SuperGrouper category, and then type Fruits. 
2. Select the rectangle SuperGrouper category, and then type 

Vegetables.
 Here is what the diagram looks like now:
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Changing the colours of a SuperGrouper shape
SuperGrouper shapes are formatted in the same way as symbols.
1. Select the Vegetables SuperGrouper category.
 The Symbol Colours tool appears on the Formatting toolbar. 

2. On the Symbol Colours tool, click the Fill Colour button, and 
then click a new colour on the palette.

3. Select the Fruits SuperGrouper category.

4. Using the Symbol Colours tool on the Formatting toolbar, try 
changing the colours of the Fruits SuperGrouper category.
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Removing a symbol from a SuperGrouper 
category
• To remove the Main Idea symbol from the Vegetables SuperGrouper 

category, select the Main Idea symbol, and then click the Clear 
button on the Picture toolbar.

 –or–

 Drag the symbol to the Symbol palette to delete it.

Adding symbols to a SuperGrouper category
To add symbols to each SuperGrouper category you simply drag and 
drop them from the Symbol palette.

1. On the Symbol palette, click the Pick Library  button , 

2. Scroll down the list to Food and Health, and then click Fruits  
and Veggies.

3. Drag several symbols to the Fruits SuperGrouper category.
4. Drag several symbols to the Vegetables SuperGrouper category.
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Viewing SuperGrouper categories in Writing View
Switching to Writing View provides a visual and written list of the items 
in each SuperGrouper category.

• To switch to Writing View, click the Go to Writing View button  
on the Picture toolbar.

 This is what the SuperGrouper categories look like in Writing View:

  The titles of the SuperGrouper categories assume a top-level 
position, and the symbols in each SuperGrouper category are 
supporting ideas. Any changes you make here will be reflected in 
Picture View.
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Closing your project and returning to the  
Kidspiration Starter
Congratulations! You have completed Tutorial Three: Categorising 
ideas using the SuperGrouper tool. Close this project and continue to 
Tutorial Four: Creating activities using the Teacher menu.
• To close your project and return to the Kidspiration Starter, click 

the Go to Starter button.
 

When you return to the Kidspiration Starter, you are prompted to 
save the open project. Click Yes to save the project.
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Tutorial Four: Creating activities using the  
Teacher menu
The Teacher menu provides controls for setting up and customising 
activities. In this lesson, you will create a new Kidspiration activity in 
Picture View called “Four Facts About Elephants.” You will learn to 
do the following:
• Enable and add a password to the Teacher menu

• Add an Internet hyperlink

• Create a Teacher symbol

• Lock a symbol

• Use Kidspiration’s audio tools

• Save your project using the Activity Wizard
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Creating a new activity in Picture View
1. Start Kidspiration.

2. Click the Picture View button to start a new diagram. 

3. In the Main Idea symbol, type Four Facts About Elephants.

4. Click the Add Symbol button on the Picture toolbar four times.

5. On the Symbol palette, type elephant into the box and click the  
Find button. 

6. Click the elephant symbol to replace the round symbol. Move the 
bottom symbols so your diagram looks like this:
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Enabling the Teacher menu
When you enable the Teacher menu, you make the commands on the 
Teacher menu available.

• To enable the Teacher menu, click Enable Teacher Menu on the  
Teacher menu.

 When the Teacher menu is enabled, a tick appears next to  
the command.

Adding a password to the Teacher menu
You can create a password for the Teacher menu to prevent pupils 
from changing your preferences.

1.  On the Teacher menu, choose Application Options.

2.  Place a tick in the box next to Password Enabled.
3.  Click the Set Password button.
 The Set Password dialogue box appears.

4.  In the Enter Password box, type the password you want to use.

5. In the &RQ¿UP�3DVVZRUG box, type the password again, and then  
click OK.

 When you enable the Teacher menu, you will be prompted to enter 
your password.

 Note: If you forget your password, you can always use the 
password “Kidspiration3” to enable the Teacher menu.

Adding an Internet hyperlink
You can easily add Internet hyperlinks to ideas, notes, symbols 
and links. Hyperlinks can be added by simply typing the URL, for 
example, “www.inspiration.com.” You can also assign a hyperlink to 
selected text.
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1.  Click in the upper left corner of the diagram.
 The crosshair   shows you where the new symbol will appear.

2. On the Symbol palette, click the thinking bubble symbol to add it 
to the diagram, and then type Learn more about elephants on the 
Internet. 

3.  Select the text Learn more about elephants on the Internet.

4.  On the Teacher menu, click URL Hyperlink.
 The text Learn more about elephants on the Internet appears in the 

Hyperlink Text box.

5.  In the Hyperlink Address box, type www.worldwildlife.org/ 
elephants, and then click OK.

 The text Learn more about elephants on the Internet is now 
formatted as a hyperlink.

 You can click the link to start your browser and go to the web site.
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Creating a Teacher symbol
You can format a symbol so it appears only in Picture View. This 
feature is useful for instructions or symbols that are not relevant in 
Writing View. 
1.  Select the Learn more about elephants on the Internet symbol.

2. On the Teacher menu, click Teacher Symbol.
 The handles on a Teacher Symbol are red triangles.

3.  On the Picture toolbar, click the Go to Writing View button.
 The Learn more about elephants on the Internet symbol does not 

appear in Writing View.

4.  On the Writing toolbar, click the Go to Picture View button to  
return to Picture View.

Locking the position of a symbol
To add additional control to an activity, you can lock the position 
of a symbol or SuperGrouper shape to ensure that pupils do not 
accidentally move or delete it. When a symbol is locked, you can still 
format the symbol and edit the text.
1.  With the Learn more about elephants on the Internet symbol 

selected, click Locked Item on the Teacher menu.
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 When a Teacher symbol is locked, its handles look like this  . 
You cannot move, replace or delete a locked symbol.

Listening to the text in the diagram
Speech supports auditory learners and helps pupils develop important 
text-picture-meaning connexions. Using the Listen tool, all text can be 
read aloud.
1.  Select the Four Facts About Elephants symbol at the centre of the 

diagram.

2.  On the Picture toolbar, click the Listen button .
 The computer reads the text in the symbol.

3.  To turn the Listen tool off, click the Listen button again.

Recording words or narration
To support emerging readers, you can record words or narration and 
attach it to a symbol.
1. With the Four Facts About Elephants symbol selected, click 

Record on the Sound menu.

 To begin recording, click the Record button.

2. Say, “&DQ�\RX�¿QG�IDFWV�DERXW�WKH�QDWLYH�KDELWDWV�RI�
elephants?” 
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 When you are finished, click the Save button.

3. To play the recording, click the speaker  in the upper right 
corner of the Four Facts About Elephants symbol.
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Saving a project as an activity
Now you are ready to save your work as an activity. The Kidspiration 
Activity Wizard takes you step-by-step through the process of creating 
an activity. You can save the activity to any location. 

1.  On the Teacher menu, click Save With Activity Wizard….

 The Kidspiration Activity Wizard opens. Click Next.

2.  Select All Libraries, and then click Next.

3.  Review the Picture View Defaults, and then click Next.

4.  Review the Text Defaults, and then click Next.

5. Review the Writing View defaults, and then click Next.

6.  Select Kidspiration Activities Folder.
7.  To save the activity in the “Science” category in the Kidspiration 

Starter, click the Science button.

8.  To save the activity, click the Save Activity button.
 Four Facts About Elephants is now available as an activity in the 

Kidspiration Starter under the “Science” category.

9.  In the Success dialogue box, click OK.
 The diagram closes and you return to the Kidspiration Starter.
Congratulations! You have finished the Learning Kidspiration, Picture 
and Writing View Tutorials. 
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Chapter 4: Learning Kidspiration®,  
Maths View Tutorials
This section of the Getting Started Guide is composed of three 
tutorials designed to get you started working in Kidspiration’s Maths 
View. The first tutorial covers Kidspiration’s five Maths Tools, 
showing each tool and its functionality via a multiple page project. 
The second tutorial demonstrates how to complete a project in the 
Step Workspace, and the third and final tutorial is a brief introduction 
to using the Free Workspace. It should take around 30 minutes to 
complete the three Maths View tutorials.
You use Kidspiration the same way as most Mac OS® and Windows® 
programs. For example, as you work, you use the mouse to drag 
objects and to select text. You also click and double-click, and enter 
information using the keyboard. If you are not familiar with doing 
these things, take a moment now and refer to the user’s guide that 
came with your computer.

Conventions we used
When we refer to program features in instructions, they appear 
in bold.  For example, “Click the Maths View button on the 
Kidspiration Starter.” When you are asked to enter specific text, the 
text you type appears in bold as well. For example, Ella, Henry and 
Lily shared 12 sweets equally.

How we organised the tutorials
In each tutorial, you will follow a series of step-by-step instructions to 
create a project in Maths View. When you finish the tutorials, you will 
be ready to create new projects in Maths View on your own.
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Tutorial One: Using Maths View’s  
Maths Tools
In this tutorial, you will create a new Kidspiration project using 
multiple pages to explore each of Maths View’s Maths Tools. 

• Using Kidspiration Colour Tiles™, you will explore maths 
concepts as you represent maths expressions and explore area.

• Using Kidspiration Pattern Blocks™, you will build designs with 
line symmetry, and identify and count shapes.

• Using Kidspiration Base Ten Blocks™, you will represent 
quantities and regroup within multi-digit addition and subtraction 
problems.

�� 8VLQJ�.LGVSLUDWLRQ�)UDFWLRQ�7LOHV���\RX�ZLOO�¿QG�HTXLYDOHQW�
fractions.

• Using Kidspiration Fraction Boxes™, you will represent 
IUDFWLRQV��¿QG�FRPPRQ�GHQRPLQDWRUV�DQG�RSHUDWH�RQ�IUDFWLRQV�

In the process, you will also learn to do the following:

• Create a multiple page project in Kidspiration’s Maths View

�� $GG�\RXU�QDPH�DQG�VDYH�\RXU�ZRUN

• Work with items from the Maths palette

• Use the tools on the Bottom toolbar

• Undo and redo your work

• Use the Teacher menu

• Print your project
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Starting Kidspiration

To start Kidspiration on a Macintosh:
• Open the Kidspiration 3 IE folder and double-click the 

Kidspiration 3 IE icon.

The Kidspiration Starter opens.

To start Kidspiration in Windows:
• Click the Start button, point to Programs and click  

Kidspiration 3 IE.

 The Kidspiration Starter opens.

The Kidspiration Starter is the place where you start new projects, 
open existing projects and use the many different Kidspiration 
activities. You will begin by clicking the Maths View button to open 
the Maths Tool Starter.
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Kidspiration Colour Tiles
We are going to start our project using the Kidspiration Colour Tiles 
Maths Tool. 
• Click the Colour Tiles button on the Maths Tool Starter.

 A new blank workspace opens in the Kidspiration Colour Tiles 
Maths Tool.

Adding your name to the project
1. On the Maths toolbar, click the Pupil Name button.

2. Type your name in the box where indicated.
 For the examples in this tutorial we will use the name “Glenna.”
3. To choose where you want the name to appear on the page, select 

Left, Centre or Right.
 A preview of how the name will appear on the page is displayed in 

the box on the right side of the dialogue box.
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4. Click OK.
 The pupil name appears in the title bar of the document.

Saving your work
1.  On the File menu, click Save.
2.  In the folder list, click the folder where you want to save the 

project.
3.  Type a name for the project, and then click Save.
 Kidspiration suggests the name “Glenna” based on the pupil name, 

but you can use a different name.

Using a Maths Text Box
Maths Text Boxes allow pupils to describe their work with words, 
numbers and maths notation, including structured frames for writing 
fractions, division problems and vertical maths notations. Maths Text 
Boxes also allow teachers to place instructions and helpful text in 
projects.
1.  Click the Maths Text Box  in the Maths palette and drag it 

onto your workspace.
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2.  Click inside the text box and write Use colour tiles to show 4 plus 3 
and 3 minus 1, but follow the steps below so it looks like this: 

 

3.  Click the Open Maths Frame button  on the Bottom toolbar to 
create the vertical frames and use the Plus Sign  and Minus Sign 

 buttons on the Bottom toolbar to add the plus and minus signs.
4.  Enlarge the text size by clicking the Resize Text button on the 

Bottom toolbar once. 
5.  Click outside the box and then back on it to select it. When a text box 

is selected, it has corner handles .
6.  Resize the text box by dragging on one or more of its corner handles 

so that all of the text fits on one line. 
7.  Move the text box up so it is near the top of the workspace.
 Note: If you make a mistake in your work, you have several options 

on the Maths toolbar:
• You can delete an item by selecting it and clicking the Clear button

on the Maths toolbar.

 -or–

• You can undo up to the last eight changes in your project by 
clicking the Undo button on the Maths toolbar.

 –or–

• You can redo up to the last eight changes you used the Undo button

  to undo by clicking the Redo button  on the Maths toolbar. 
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Moving colour tiles onto the workspace
Now you’ll bring out some colour tiles to represent the first 
expression.
1.  Click on the red colour tile on the Maths palette and drag it onto 

the workspace. Do this three more times or just click on the tile in 
the palette three more times to create multiple instances of it. 

2.  Align the tiles horizontally on your workspace, somewhere below 
the text box. Notice that the tiles “snap” together as you are lining 
them up. 

3.  Drag out three yellow tiles and snap them into alignment with the 
four red tiles.

Resizing manipulatives on the workspace
• Resize all of the colour tiles on the workspace by clicking the 

Resize Manipulatives button once on the Bottom toolbar. 
 Your project should look something like this:
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Using the Cross-Out Stamp
Use the Cross-Out Stamp to mark tiles and visually represent the 
subtraction in second expression.
1.  Drag out three blue tiles and align them below the first 

representation.
2.  Select one blue tile. 
3.  Now click the Cross-Out Stamp button on the Bottom 

toolbar. 
 The tiles should look like this:

Adding pages to your project
Maths View allows for the creation of multiple pages within a single 
document, giving teachers the opportunity to create an extended 
activity with multiple parts, or pupils the opportunity to show their 
thinking using one or more tools. 
Now you’ll learn how to add a new page to your project so you can 
continue working with Kidspiration Colour Tiles.
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 1.  Click the Go To Page button on the Maths toolbar to open 
the Choose Page dialogue.

2.  Click the Add Page button to add a new page.
3.  Choose Colour Tiles from the Maths Tool Starter.
 Note: When you have more than one page in a project, a page 

number for the page you are working on appears in the upper-left 
corner of the workspace.

Using a background grid
A background grid can help you to organise colour tiles on the 
workspace, making it easier to create bar charts, build models, and 
explore perimetre and area.
1.  Click the Show Background Grid button on the Bottom 

toolbar.
2.  Resize the grid to large by clicking the Resize Manipulatives 

button  on the Bottom toolbar one time.
3.  Drag one Maths Text Box onto the workspace.
4.  Type 6 square units into the box.
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5.  Position your cursor on the workspace and click a colour tile in the 
Maths palette six times.

6.  Move tiles on the grid to make a rectangle with an area of 6 square 
units. 

 Notice that the tiles “snap” into position on the grid.
7.  Continue bringing out tiles to create all possible rectangles with 

areas of 6 square units.
 Your project should look something like this:

Kidspiration Pattern Blocks
Now let’s add another new page and learn how to use the Kidspiration 
Pattern Blocks Maths Tool.
1.  Click the Go To Page button on the Maths toolbar to open 

the Choose Page dialogue, and click the Add Page button 
 to add a third page to your project.

2.  Choose Pattern Blocks from the Maths Tool Starter.
3.  Click the Maths Text Box in the Maths palette and drag it 

onto your workspace, positioning it toward the top centre.
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4.  Click inside the text box and write Line Symmetry, but follow the 
steps below so it looks like this: 

5.  Enlarge the text size by clicking the Resize Text button on the 
Bottom toolbar once. 

6.  Click outside the text box and then back on it to select it. When a 
text box is selected, it has corner handles .

7.  Bold the text by clicking the Bold button  on the Bottom 
toolbar. 

8.  Resize the text box by dragging on one or more of its corner 
handles so that all of the text fits on one line. 

9.  Add a border and a background colour to the text box by clicking 
the Border button  on the Bottom toolbar, and then the 
Background Colour button next to it. Choose a background 
colour from the palette.

Locking an item on the workspace
Now that your Maths Text Box is set up, you can lock it so that it 
cannot be moved or deleted. 
• With the text box selected, click Locked Item on the Teacher 

menu. 
 A tick appears next to Locked Item when the text box is locked, and 

the corner handles change on the box.
 Note: The Teacher menu must be enabled for the Locked Item 

option to appear. To turn the Teacher menu on or off, click Enable 
Teacher Menu on the Teacher menu. 
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Creating a password for the Teacher menu
You can create a password for the Teacher menu to prevent pupils 
from using it and changing teacher preferences. 
1.  On the Teacher menu, click Application Options.
2.  Place a tick in the box next to Password Enabled.
3.  Click Set Password.
4.  The Set Password dialogue box appears.
5.  Type the password you want to use in the Enter Password box.
6.  Type the password again in the &RQ¿UP�3DVVZRUG box, and then 

click  OK.
 When you enable the Teacher menu, you will be prompted to enter 

your password.
 Note: If you forget your password, you can access the Teacher 

menu by using the password “Kidspiration3.”

Moving pattern blocks onto the workspace
Now you’ll bring out some pattern blocks to create a design with line 
symmetry.
1.  Click on the blue hexagon on the Maths palette and drag it onto 

the workspace. Do the same with the red square and the yellow 
trapezoid. 

2.  Click twice on the green triangle on the Maths palette to add two 
of them to the workspace.



99

Chapter 4: Learning Kidspiration®, Maths View Tutorials

3.  Click and drag each pattern block into a design that looks like this:

 Notice that the blocks “snap” together into position. 

Using the Rotation tools
Use the Rotation tools on the Maths toolbar to rotate blocks on the 
workspace when building patterns, models and designs.
1.  Drag two of the large purple rhombuses onto the workspace, one 

on either side of your pattern.
2.  Click the rhombus on the left to select it, then click the Rotate 

Block Clockwise button on the Bottom toolbar twice.
 Note: You can also rotate shapes on the workspace by selecting 

them and then clicking your spacebar to rotate them clockwise, or 
by holding the Shift key down and clicking your spacebar to rotate 
them anticlockwise.
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3.  Drag your rhombus into position so that it “snaps” into place 
against the hexagon and the trapezoid.

4.  Now select the rhombus on the right and repeat step number 3 
above.

 Your design should now look like this:

Creating a line of symmetry
You can use a line from the Maths palette to reinforce the concept of 
symmetry in the Kidspiration Pattern Blocks Maths Tool.
1.  Click and drag a line from the Maths palette onto the 

workspace.
2.  With the line selected, drag on one of its handles while you hold 

down the Shift key, and move the line into a vertical position. 
(When you hold down the Shift key, you can rotate a line in 45 
degree increments.) 

3.  Drag the line over the middle of the design so it bisects it.
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4.  You may need to lengthen the line so it extends a little beyond the 
top and bottom of the design. 

 To lengthen the line, drag on one of its handles. Your design should 
now look something like this:

5.  Click the Resize Manipulatives button on the Bottom 
toolbar once to enlarge your design on the workspace.

Selecting multiple items on the workspace
1.  After you resize items, you may need to adjust their location on the 

workspace.
• To multi-select items on the workspace, click an area of open 
ZRUNVSDFH�DQG�GUDJ�\RXU�FXUVRU�RYHU�WKHP��

 –or–

• Hold down the Shift key and click each item you want to select.

 Tip: You can also turn Shift-select on, which allows you to select 
multiple items on the workspace without holding down the 
Shift key. Click the Shift-select button on the Bottom toolbar 
to turn Shift-select on or off. The Shift-select button appears on 
Maths View’s Bottom toolbar when Stylus Mode is turned on in 
Application Options on the Teacher menu.
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 Note: The Teacher menu must be enabled in order to access 
Application Options. To turn the Teacher menu on or off, click 
Enable Teacher Menu on the Teacher menu. 

2.  Drag the design into position on the workspace so that your project 
looks like this:

3.  Click the Go To Page button on the Maths toolbar to open 
the Choose Page dialogue, and click the Add Page button 

 to add another new page.
4.  Choose Pattern Blocks from the Maths Tool Starter again.

Working with Maths SuperGroupers™
Maths SuperGroupers are similar to the SuperGroupers in Picture 
View. They are used for grouping, sorting, categorising and counting 
activities. Here you will use Maths SuperGroupers for shape 
identification and counting.
1.  Click and drag 2 rectangular Maths SuperGroupers from the  

Maths palette onto the blank workspace on page 4, placing the 
first one toward the top centre, and the second one toward the 
bottom centre.
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2.  Click to select each one and drag on one or more of their corner 
handles to make them wide across the page. 

3.  Notice that when you have a grouper selected, a label box appears 
in dotted lines at the top. 

4.  Double-click inside the label boxes one at a time to select them and 
a cursor will appear. 

 Type 5 blue hexagons into the first one and 4 green triangles into 
the second one. 

5.  Change the background colour of one of the groupers to give your 
document visual interest. 

 Select the 4 green triangles grouper and choose light blue from the 
Colour buttons on the Bottom toolbar. 

6.  Now that your groupers are ready, use pattern blocks to represent 
the labelled quantities. Drag 5 blue hexagons from the Maths 
palette into the first grouper, and 4 green triangles into the second 
grouper.
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 Your project should look like this:

 Note: Once manipulatives are placed inside a grouper, they will 
remain there until you remove them. Drag one of the groupers 
around the workspace and notice that the tiles move with it.

Kidspiration Base Ten Blocks
Now let’s add a fifth page to our project and learn how to use the 
Kidspiration Base Ten Blocks Maths Tool.
1. Click the Go To Page button on the Maths toolbar to open 

the Choose Page dialogue, and click the Add Page button
.

2. Choose Base Ten Blocks from the Maths Tool Starter.

Adding a place value mat
You can add a place value mat to the background of your Kidspiration 
Base Ten Blocks workspace as a visual structure for learning about 
place value and modelling problems. The mat has three basic layout 
options to choose from: a full-page mat with columns labelled 
“Hundreds,” “Tens” and “Ones,” a 3/4-page mat with columns 
labelled “Hundreds,” “Tens” and “Ones” and room for instructions 
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or example work above, and a full-page mat with columns labelled 
“Thousands,” “Hundreds,” “Tens” and “Ones.” 
1. Click the Place Value Mat button on the Bottom toolbar twice to 

select the “Hundreds,” “Tens” and “Ones” place value mat with the 
open area at the top.

2.  Click the Maths Text Box in the Maths palette and drag 
it onto the workspace, into the open area at the top of the place 
value mat.

3. Click inside the text box and write Use base ten blocks to solve 
176 plus 36, but follow the steps below so it looks like this: 

4.  Click the Open Maths Frame button on the Bottom toolbar 
to create the vertical frame and click the Plus Sign button on 
the Bottom toolbar to add the plus sign.

5.  Enlarge the text size by clicking the Resize Text button on 
the Bottom toolbar once. 

6.  Click outside the box and then back on it to select it. When a text 
box is selected, it has corner handles .

7.  Resize the text box by dragging on one or more of its corner 
handles so that all of the text fits on one line. 

8.  Move the text box up so it is near the top of the workspace.

Moving base ten blocks onto the workspace
Now you’ll bring out some base ten blocks and arrange them on the 
place value mat to represent the addition problem.
1.  Click on the flat in the Maths palette and drag it into the 

“Hundreds” column on the place value mat. 
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2.  Drag a horizontal rod into the “Tens” column and then click the 
same rod successively in the Maths palette to create six more 
instances of it.

3.  Finally, add six units to the “Ones” column, by clicking somewhere 
inside the column, and then clicking on the unit in the Maths 
palette six times.

4. To position blocks at the top and centre of their columns, simply 
click on the flat and drag it into position.

 Multi-select the blocks in the other two columns, one column at a 
time, and click and hold your cursor on one of the blocks to drag 
them all into position.

You have now represented 176 on the place value mat, and your 
project should look something like this:

5. Now to represent 36, you will bring in additional blocks.
 Add three new horizontal rods to the “Tens” column, and six new 

units to the “Ones” column to represent 36. 
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Changing the colour of base ten blocks
To help distinguish between the two addends being represented on the 
place value mat, you can change the colour of the blocks representing 
36. 
• To change the colour of the blocks representing 36, click each one 

or multi-select all of them (you can multi-select across columns on 
the mat) and then click one of the Colour buttons on the Bottom 
toolbar. To select a colour from the expanded palette, click the More 
Colours button .

 Your project should now look something like this:

Solving an addition problem by regrouping 
blocks
Now you are ready to solve the problem using the base ten blocks on 
the place value mat.
1.  Begin in the “Ones” column and regroup by multi-selecting six 

blue units and four red units and then clicking the Group button
on the Bottom toolbar. 

2.  You now have a new rod composed of six blue units and four red 
units. 

 Drag this rod into the “Tens” column to represent “carrying.”
3.  Now multi-select ten of the rods in the “Tens” column and click the 

Group button again. 
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4. Move this new flat into the “Hundreds” column.
5. To tidy up your project, you can now drag the remaining blocks in 

the “Tens” and “Ones” to the top of their columns.
6. You have solved the addition problem using base ten blocks on a 

place value mat and the answer is 212. 
Your project should look something like this:

Locking a page 
Before moving on to page 6, you might want to lock page 5. The 
ability to lock pages in a document allows you to set up an example 
within an activity and prevent pupils from altering any of the items on 
the workspace, or adding to the page.

• To lock page 5, click Locked Page on the Teacher menu.

 A tick appears next to Locked Page when the page is locked, and a 
Locked Page indicator appears next to the page number. 

 Note: The Teacher menu must be enabled for the Locked Page 
option to appear. To turn the Teacher menu on or off, click Enable 
Teacher Menu on the Teacher menu. 

Changing the labels on a place value mat
You can change the column labels on a place value mat to whatever 
you like. For instance, you may want to change the labels from 
“Hundreds,” “Tens” and “Ones,” to “Flats,” “Rods” and “Units” to 
more closely align with your curriculum.
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1. Click the Go To Page button on the Maths toolbar to open 
the Choose Page dialogue, and click the Add Page button

to add another new page.
2. Choose Base Ten Blocks from the Maths Tool Starter again.
3.  Click the Place Value Mat button on the Bottom toolbar once to 

add a new mat to your workspace.
4.  Double-click inside a label to select it.
 You should see a cursor appear. 
5.  Select the existing text by double-clicking inside the label one  

more time.
 –or– 
 Click and drag over the existing text to select it.
 –or– 
 Use your Backspace or Delete key (Windows) or your Delete key 

(Macintosh) on your keyboard to remove the existing text.
6.  Type Flats into the first label, Rods into the second one and Units 

into the third one.
7.  Drag a Maths Text Box into the “Flats” column to write a 

subtraction problem.
8.  Click the Open Maths Frame button on the Bottom toolbar and 

write the expression 234 minus 18, using the Minus Sign button 
on the Bottom toolbar to represent minus. The text box should 
look something like this:

9. Drag blocks into the columns to represent 234. You should have 
two flats in the first column, 3 rods in the second column and four 
units in the third column.
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10. Click the Resize Manipulatives button on the Bottom 
toolbar once to make them larger.

11. Now move the blocks around in the columns so your project looks  
something like this:

 You can click and drag the rods and units around one at a time, or 
multi-select all of the them in each column and drag them into their 
new position. 

Solving a subtraction problem by regrouping 
blocks
Now you are ready to solve the equation using the base ten blocks on 
the place value mat.
1.  Since eight units cannot be taken away from four units, you need to 

“borrow” from the rods. 
 Use the Break Blocks Apart button to break the bottom 

rod in the “Rods” column into 10 units. 
2.  Move the new units into the “Units” column.
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Using the Cross-Out Stamp
Use the Cross-Out Stamp to mark blocks and represent subtracting the 
quantity 18.  
1. Select eight units in the “Units” column and click the Cross-Out 

Stamp button on the Bottom toolbar. 
2.  Select the bottom rod in the “Rods” column and click the Cross-

Out Stamp button again.
3.  You have now visually represented subtracting 18 using base ten 

blocks on a place value mat and the solution is 216.
 Your project should look something like this:

Kidspiration Fraction Tiles
Now let’s add a seventh page to our project and learn how to use the 
Kidspiration Fraction Tiles Maths Tool.
1. Click the Go To Page button on the Maths toolbar to open 

the Choose Page dialogue, and click the Add Page button
.

2. Choose Fraction Tiles from the Maths Tool Starter.
3.  Click the Maths Text Box in the Maths palette and drag 

it onto your workspace.



112

Kidspiration® 3
 
Getting Started Guide

4.  Click inside the text box and write Find three fractions that are 
equivalent to one-half, but follow the steps below so it looks like 
this: 

5.  Click the arrow to the right of the Open Maths Frame button
 in order to see all of the Bottom toolbar.

6.  Click the Fraction Frame button at the end of the toolbar to 
create the fraction.

7.  Enlarge the text size by clicking the Resize Text button on the 
Bottom toolbar once. 

8.  Click outside the box and then back on it to select it. When a text 
box is selected, it has corner handles .

9. Resize the text box by dragging on one or more of its corner 
handles so that all of the text fits on one line. 

10. Click and drag the box up so it is positioned at the top of the 
workspace.

Using whole trays
Whole trays can be used as a container to hold fraction tiles. A whole 
tray represents 1 (or whole) when filled with tiles, and is the same size 
as the tile from the Maths palette representing 1 (or whole). 
1.  Click on the whole tray in the Maths palette and drag it onto  

the workspace.
2.  Either drag three more out or click on the whole tray in the Maths 

palette three more times successively to create three more trays.
3.  Align them top-to-bottom vertically on the workspace. Notice how 

the whole trays “snap” together as you line them up.
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Moving fraction tiles onto the workspace
Now that the whole trays are ready, use fraction tiles to represent one-
half and its equivalent fractions.
1.  Click and drag a 1/2 tile from the Maths palette into the first 

whole tray.
2.  Drag fraction tiles out into the trays below to represent fractions 

that are equivalent to 1/2, beginning with 1/4 and ending with 1/8. 
Notice how the tiles “snap” into position. 

 Note: After the first tile is dragged into each whole tray, successive 
clicks on the tile in the Maths palette will “snap” the next tile into 
place.

Your project should now look something like this:

Hiding fraction labels

,I�\RXU�DFWLYLW\�UHTXLUHV�LW��\RX�FDQ�KLGH�IUDFWLRQ�ODEHOV��

• Hide the fraction labels by clicking the Hide Fraction Labels  
button on the Bottom toolbar. Click it again to turn fraction 
labels back on.



114

Kidspiration® 3
 
Getting Started Guide

Kidspiration Fraction Boxes
Now let’s add an eighth page to our project and learn how to use the 
Kidspiration Fraction Boxes Maths Tool.
1. Click the Go To Page button on the Maths toolbar to open 

the Choose Page dialogue, and click the Add Page button
.

2. Choose Fraction Boxes from the Maths Tool Starter.
3.  You will use Maths Text Boxes to write two fractions. Click the 
 Maths Text Box in the Maths palette and drag it onto the 

left side of your workspace, toward the top.
4.  Drag another one out and place it below the first one.
5.  Add fractions to the text boxes following the steps below: 
6.  Click the arrow to the right of the Open Maths Frame button

in order to see all of the Bottom toolbar.
7.  Click back on the first text box to select it and click the Fraction 

Frame button at the end of the toolbar. Type text into the 
frames to create the fraction 3/4. 

8.  Click on the second text box and create the fraction 5/8 in the same 
way.
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Limiting the denominator in fraction boxes
For this Kidspiration Fraction Boxes project, you may want to limit 
the denominator on all fraction boxes in this document, the default 
maximum for which is 36. 
1.  Select Limit Denominator... on the Teacher menu. 
2.  Enter a new denominator of 16 in the Set Denominator dialogue 

box.
 Notes: 

�� <RXU�GRFXPHQW�PXVW�QRW�KDYH�DQ\�IUDFWLRQ�ER[HV�RQ�LW�\HW��,I�
you try to limit the denominator with fraction boxes already 
in the document, you will get a warning message to clear all 
fraction boxes from the document before setting a new maximum 
denominator.

• When you limit the denominator, it applies to fraction boxes all 
pages in the current document.

• The Teacher menu must be enabled for the Limit Denominator 
option to appear. To turn the Teacher menu on or off, click 
Enable Teacher Menu on the Teacher menu.

Dragging fraction boxes onto the workspace
1.  To visually represent the fractions, click the fraction box  

in the Maths palette and drag it onto the workspace to the right of 
the first text box.

2.  Either drag another one out or click on the fraction box again in the 
Maths palette to create another one on the workspace.
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3.  Align the second one with the first one vertically on the workspace. 
Notice how they “snap” into position when you have them aligned.

 Note: To move a fraction box, click in the grey area and drag the 
box.

Changing the denominator in a fraction box
When you first drag a fraction box out onto the workspace, it has only 
one part, or a denominator of one. 
1.  To increase the denominator on the top fraction box, click the 

Increase Denominator button four times to divide it into four 
parts.

2.  Repeat this with the lower fraction box to give it eight parts.
 Tip: You can also click and hold down the Increase and Decrease 

Denominator buttons to change the denominator.

Adding colour to the parts and activating tiles
Filling the parts within fraction boxes with colour and/or a pattern 
makes them active.
1.  Colour 3/4 by multi-selecting the first three parts in the top fraction 

box (hold down the Shift key and click each item you want to 
select).

2.  With the three parts selected, click one of the Colour buttons
on the Bottom toolbar to represent 

3/4. To select a colour from the expanded palette, click the More 
Colours button .
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3.  Now multi-select the first five parts in the lower fraction box and 
colour them a different colour to represent 5/8.

 You now have active tiles in both fraction boxes.
Your project should look something like this:

Moving the tiles inside and between fraction 
boxes
Active tiles can be moved into empty parts within fraction boxes.

�� &OLFN�WKH�IDU�ULJKW�DFWLYH�����WLOH�LQ�WKH�WRS�IUDFWLRQ�ER[�DQG�GUDJ�
it into the empty part on its right.

Active tiles can also be moved into empty parts in another fraction 
box if the denominators between the two are compatible. For example, 
a 1/4 tile can move to two empty 1/8 parts.

�� &OLFN�WKH�IDU�ULJKW�DFWLYH�����WLOH�LQ�WKH�WRS�IUDFWLRQ�ER[�DQG�GUDJ�
it into the last two empty parts on the lower fraction box, as 
shown below:
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�� 1RZ�PXOWL�VHOHFW�WKH�ODVW�WZR�DFWLYH�����WLOHV�DQG�PRYH�WKHP�
back into the upper fraction box, “snapping” them into place 
EHVLGH�WKH�RWKHU�DFWLYH�����WLOHV�

Your project should look something like this:

 1.  Click the Go To Page button on the Maths toolbar to 
open the Choose Page dialogue.

2.  Click the Add Page button to add another new page.
3.  Choose Fraction Boxes from the Maths Tool Starter again.
4.  Drag a Maths Text Box onto the open workspace. 
5.  Use the Fraction Frame and the Plus Sign buttons from the 

Bottom toolbar to create the expression 2/3 plus 3/4.
6.  Enlarge the text size by clicking the Resize Text button on 

the Bottom toolbar once. 
7.  Click outside the box and then back on it to select it. When a text 

box is selected, it has corner handles .
8.  Click and drag the box up so it is positioned at the top of the 

workspace.
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Finding and applying a common denominator 
1.  Click the fraction box in the Maths palette twice to place 

2 new fraction boxes onto the workspace.
2.  Position them so that they “snap” into vertical alignment on the 

workspace and are centred below the text box.
3.  Click and hold the Increase Denominator button on the top 

fraction box three times to divide it into three parts.
 Repeat this step with the lower fraction box to give it four parts.
4.  Select the first empty part in the upper fraction box and click one 

of the Colour buttons on the Bottom 
toolbar twice to colour two tiles, or 2/3 of the upper fraction box. 

5.  Do the same with the lower fraction box with a different colour to 
represent 3/4.

Your project should look something like this:

6.  Now click the Increase Denominator button on the upper fraction 
box and watch the appearance of the box. 
• When the number of parts is coloured red, it indicates that the 
QHZ�GHQRPLQDWRU�GRHV�QRW�\LHOG�D�IUDFWLRQ�WKDW�LV�HTXLYDOHQW�WR�
�����:KHQ�DQ�HTXLYDOHQW�IUDFWLRQ��VXFK�DV������KDV�EHHQ�UHDFKHG��
the background of the fraction box turns blue, and the Apply 
Denominator button appears.
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• Also, as you change the denominator in a fraction box containing 
DFWLYH�WLOHV��WKH�RULJLQDO�GLYLVLRQV�DUH�VKRZQ�ZLWK�GRWWHG�OLQHV�

7. To change the fraction into a new, equivalent fraction, click the 
Apply Denominator button to activate the new number of cells, 
and the dotted lines will go away. 

8. Experiment with increasing the denominator in both fraction boxes 
to find the common denominator of 12. Apply it in both fraction 
boxes.

9. To add 8/12 and 9/12, you can multi-select four tiles from the 
lower fraction box and drag them into the upper one, and see the 
answer to the equation, which is 1 5/12.

10. Use another text box to record your answer.
Your project should look something like this:
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11. Now click the Go To Page button on the Maths toolbar to 
open the Choose Page dialogue.

12. Click the Add Page button to add another new page.
13. Choose Fraction Boxes from the Maths Tool Starter one last 

time.
14. Drag two text boxes out onto the left side of the workspace, one at 

the top and one toward the middle. 
15. Add the expression 1/2 times 8/9 to the top one, and 3/4 minus 1/4 

to the lower one, using the Fraction Frame, Multiplication Sign 
and Minus Sign buttons on the Bottom toolbar. 

16. Now bring out two fraction boxes and position them below the text 
boxes, centred across the workspace.

17. Click the Resize Manipulatives button on the Bottom 
toolbar once to make them larger.

18. You may have to adjust their position slightly after resizing them. 
Click in the grey area to select them and drag them into vertical 
alignment with each other. Notice that they will “snap” into 
position.

Using a pattern with fraction boxes
You can add a pattern to fraction tiles just like you can change a 
colour. Adding a pattern to coloured tiles can help in representing 
multiplication of fractions.
1.  To represent 8/9, select the upper fraction box, and click and hold 

down the Increase Denominator button until it has nine parts. 
2.  Click on the first part and then click a Colour button on the 

Bottom toolbar eight times to represent 8/9. 
3.  To represent “taking half of” 8/9, multi-select four of the eight tiles 

in that same fraction box and click one of the Pattern buttons
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on the Bottom toolbar. 
 You have now visually represented 1/2 of 8/9 and revealed the 

solution. 
4. Add the answer to the first problem in the upper text box. 

Represent equals 4/9 using the Equals sign and another Fraction 
Frame from the Bottom toolbar.

5. You may need to resize the text box. Click off the text box and 
back on it to select it. Drag one of the handles until the expression 
fits on one line.

 Your project should look something like this:

Marking tiles for subtraction
It is easy to mark tiles in fraction boxes to represent subtraction. When 
you mark tiles for subtraction, they will be removed when you change 
the denominator.
1.  Select the lower fraction box, and click and hold down the 

Increase Denominator button until it has four parts. 
2.  Click on the first part and then click a Colour button on the 

Bottom toolbar three times to represent 3/4. 
3.  Click the Subtraction button on the Bottom toolbar, and the 

last active tile will now be marked for subtraction.
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 You have now represented the equation 3/4 minus 1/4 equals 2/4.

4.  To reduce your answer, now you can decrease the denominator and 
remove the marked tile.
• Click the Decrease Denominator button and stop when the 
HTXLYDOHQW�IUDFWLRQ�RI�����LV�UHDFKHG�

• Click the Apply Denominator button and the fraction box now 
FRQWDLQV�RQO\���DFWLYH�WLOH�

5.  Add the answer to the second problem in the lower text box. 
Represent equals 1/2 using the Equals sign and another Fraction 
Frame from the Bottom toolbar.

6.  You may need to resize the text box. Click off the text box and 
back on it to select it. Drag one of the handles until the equation 
fits on one line.

Your project should look something like this:
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Printing your project
To print a project, click Print on the File menu.
You can also choose from the following options before printing:

 Selecting page orientation
 In Maths View, landscape orientation is the default. To switch to 

portrait orientation before printing a project:
����2Q�WKH�File menu, click Page Setup.

����1H[W�WR�Orientation, click the Portrait or Landscape icon 
(Macintosh).

 –or–

 Under Orientation, select Portrait or Landscape (Windows).

Selecting paper size
 Letter is the default paper size in Kidspiration. To select a  

different paper size:
����2Q�WKH�File menu, click Page Setup.

����,Q�WKH�Paper list, select the paper size you want (Macintosh).

 –or–

3.  Under Paper, select the paper size you want in the Size list 
(Windows).

Printing page numbers
 If you choose to print page numbers, they will appear at the bottom 

of the page. To print page numbers:
����&OLFN�WKH�Pupil Name button.

����3ODFH�D�WLFN�LQ�WKH�ER[�ZKHUH�LQGLFDWHG�
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Closing your project and returning to the 
Kidspiration Starter
Congratulations! You have completed Tutorial One: Using 
Maths View’s Maths Tools. To close your project and return to the 
Kidspiration Starter, click the Go to Starter button.

When you return to the Kidspiration Starter, you are prompted to save 
the open project. Click Yes if you want to save the project. 
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Tutorial Two: Using steps to show  
progression of work
The Step Workspace allows pupils to show and explain each step as 
they progress through a maths project. Because their work is preserved 
and duplicated as they move from one step to the next, you can see 
what their thinking process was and pinpoint any mistakes. 
Pupils can use any one of the five Kidspiration® Maths Tools with 
steps, but can only use one tool per project. In this lesson, you 
will learn to create a new project in the Step Workspace using the 
Kidspiration Colour Tiles™ Maths Tool. For specific information on 
how to use all five of the Maths Tools, refer to Chapter 4, Tutorial One. 

Starting Kidspiration
To start Kidspiration on a Macintosh:

• Open the Kidspiration 3 IE folder and double-click the  
Kidspiration 3 IE icon.

The Kidspiration Starter opens.

To start Kidspiration in Windows:
• Click the Start button, point to Programs and click  

Kidspiration 3 IE.

The Kidspiration Starter opens.
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The Kidspiration Starter is the place where you start new projects, 
open existing projects and use the many different Kidspiration 
activities. You will begin by clicking the Maths View button to open 
the Maths Tool Starter.

Starting a new Kidspiration Colour Tiles project 
using steps
To start a new Kidspiration Colour Tiles project using steps, place a 
tick in the box next to Use Steps in the Maths Tool Starter and then 
click the Colour Tiles button.

A new step workspace opens in the Kidspiration Colour Tiles Maths 
Tool, with Step 1 active and ready for you to begin your project. As 
you proceed, you may add as many steps as you like, but only two 
will be showing on the screen at any given time. The active step has a 
white background and the inactive steps are grey.
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Adding your name to a project
1.  On the Maths toolbar, click the Pupil Name button .
2.  Type your name in the box where indicated.
 For the examples in this tutorial we will use the name “Glenna.”
3. To choose where you want the name to appear on the page, select 

Left, Centre or Right.
 A preview of how the name will appear on the page is displayed in 

the box on the right side of the dialogue box.
4.  Click OK.
The pupil name appears in the title bar of the document.

Saving your work

1.  On the File menu, click Save.
2.  In the folder list, click the folder where you want to save the 

project.
3.  Type a name for the project, and then click Save.
Kidspiration suggests the name “Glenna” based on the pupil name, but 
you can use a different name.
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Setting up your project

Adding a Maths Text Box 
Maths Text Boxes allow pupils to describe their work with words, 
numbers and maths notation, including structured frames for writing 
fractions, division problems and vertical maths notations. Maths Text 
Boxes also allow teachers to place instructions and helpful text in 
projects.
1.  Click the Maths Text Box  in the Maths palette and drag it 

into Step 1, positioning it at the top and centre of the workspace.
2.  Type Show and explain your work for every step! into the Maths 

Text Box.
3.  Click outside the box and then back on it to select it. When a text 

box is selected, it has corner handles .
4.  Click and drag on the corner handles to resize the box so that all of 

the text fits on one line at the top and centre of the workspace.
5.  Drag another text box out and place it below the first one.
6.  Type the following problem into the text box: 
 Andrew, Claire and Matt split 12 sweets equally. Matt gave 

2 sweets to Claire and then Claire gave half of her sweets to 
Andrew. How many sweets do they have now?

7.  Decrease the text size by clicking the Resize Text button
on the Bottom toolbar twice. 

8.  Click outside the box and then back on it to resize the text box so 
that the text fits on two lines, positioned below the first text box.

 Note: If you make a mistake in your work, you have several 
options on the Maths toolbar:
• You can delete an item by selecting it and clicking the Clear 

button  on the Maths toolbar.
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 –or–

• You can undo up to the last eight changes in your project by 
clicking the Undo button on the Maths toolbar.

 –or–

• You can redo up to the last eight changes you used the Undo 
button to undo by clicking the Redo button  on the Maths 
toolbar. 

Adding a Maths SuperGrouper™ to your project
Maths SuperGroupers are similar to the SuperGrouper®’s in 
Kidspiration’s Picture View. They are used for grouping, sorting, 
categorising and counting activities.
1.  Click and drag a rectangular Maths SuperGrouper from the 

Maths palette onto the blank workspace.
2.  Click on one of its handles to resize it so that it fits below the text 

boxes and on the left side of the workspace, and takes up about 1/4 
of the workspace from left to right.

Duplicating items on the workspace
You will use a Maths SuperGrouper to represent each person in this 
word problem. Because you want three Maths SuperGroupers which 
are about the same size and shape, you can use Copy and Paste options 
to create two more of them on the workspace.
1.  Select Copy from the Edit menu and then click on an area of open 

workspace to the right of the first grouper. 
2.  Click Paste on the Edit menu. Move your cursor to another area of 

open workspace and click Paste again.
3.  Position the groupers in a row from left to right across the page.
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4.  Now add another text box to the right of the groupers and resize it  
so it is square and takes up the remaining space on the right side of

 the workspace. Click the Border button  on the Bottom 
toolbar to give it a border.

 You will add information to this text box later.

Labelling Maths SuperGroupers
1.  Notice that when you have a grouper selected, a label box appears 

in dotted lines at the top. 

2.  Double-click inside the first grouper’s label box to select it and a 
cursor will appear. 

3.  Type Andrew, and then select the label in second grouper and type 
Claire. Type Matt into the third one.

Your project should look something like this:

Locking items on the workspace
Now that Step 1 is set up, you can lock its contents so that they cannot 
be moved or deleted. 
1.  First you’ll need to multi-select the three Maths SuperGroupers by 

holding down the Shift key and clicking each of them.
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 Tip: You can also turn Shift-select on, which allows you to select 
multiple items on the workspace without holding down the 
Shift key. Click the Shift-select button on the Bottom toolbar 
to turn Shift-select on or off. The Shift-select button appears on 
Maths View’s Bottom toolbar when Stylus Mode is turned on in 
Application Options on the Teacher menu.

  Note: The Teacher menu must be enabled in order to access 
Application Options. To turn the Teacher menu on or off, click 
Enable Teacher Menu on the Teacher menu. You can create a 
password for the Teacher menu to prevent pupils from using it and 
changing teacher preferences. 
• On the Teacher menu, click Application Options.

• Place a tick in the box next to Password Enabled.

• Click Set Password.

 The Set Password dialogue box appears.

• Type the password you want to use in the Enter Password box.

• Type the password again in the &RQ¿UP�3DVVZRUG box, and 
then click OK.

• When you enable the Teacher menu, you will be prompted to 
enter your password.

 Note: If you forget your password, you can access the Teacher 
menu by using the password “Kidspiration3.”

2.  With the groupers selected, click Locked Item on the Teacher 
menu. 

 A tick appears next to Locked Item when the groupers are locked, 
and the corner handles change.
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Notes: 
• The Teacher menu must be enabled for the Locked Item option 

to appear. To turn the Teacher menu on or off, click Enable 
Teacher Menu on the Teacher menu. 

• If you were to choose the Locked Step option from the Teacher 
PHQX��LW�ZRXOG�SUHVHUYH�6WHS���EXW�LW�ZRXOG�QRW�DOORZ�SXSLOV�WR�
add to the step in any way. Nor would any of your work so far 
transfer to subsequent steps. Be aware that this option exists.

3.  Now lock the three Maths Text Boxes in Step 1 as well.

Duplication options for Maths Text Boxes in 
steps
When you add a step in the Step Workspace, your previous work is 
duplicated in the new one. However, by default, Maths Text Boxes do 
not duplicate. In this project, since it will help if you can continue to see 
the story problem in subsequent steps, we will change the default setting 
for specific Maths Text Boxes.
1.  Click to select the text box where you have written the story 

problem beginning with Andrew…. 

2.  Select Maths Text Box in Next Step on the Teacher menu and 
choose Duplicate With Contents.

Since you will be explaining your work in the empty box in each 
step, you want the box itself to appear in each new step, but without 
transferring the contents from the previous step. 
• Select the empty text box and select Maths Text Box in Next Step 

on the Teacher menu and choose Duplicate Without Contents.
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Solving the problem

$GG�FRORXU�WLOHV�WR�6WHS���WR�EHJLQ�VROYLQJ�WKH�SUREOHP�

1.  Click the red colour tile in the Maths palette and drag it into the 
first grouper.

2.  Click on the red colour tile again in the Maths palette to create 
three more in the grouper. It’s okay if tiles overlap.

3.  Repeat these steps to finish splitting the “12 sweets.” Add four 
green colour tiles to the second grouper and four blue colour tiles 
to the third one.

 You have now represented the first part of the word problem.
4.  Describe what you did in the blank text box on the right:

Step 2

1.  Click the Add Step button on the Maths toolbar and add 
Step 2. Notice what gets duplicated based on the settings you chose 
in Step 1.

2.  Now represent the next part of the problem by multi-selecting two 
of Matt’s blue colour tiles and dragging them into Claire’s grouper. 
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3.  Describe what you did in the blank text box on the right:

Step 3

1.  Click the Add Step button on the Maths toolbar again and add  
Step 3. 

2.  Now represent the final step in the problem by multi-selecting three 
of Claire’s green colour tiles and dragging them into Andrew’s 
grouper. 

3.  Describe what you did in the blank text box on the right. You can 
also resize text and make your text box containing the answer 
smaller.

Step 3 of your project should look something like this:
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Deleting and navigating between steps 
If you add another step by accident, you can delete it. Note that you 
can only delete the last step at any time from a maths project in the 
Step Workspace.
1.  Add a 4th step to your project.
2.  To delete it, click the Delete Step button on the Maths 

toolbar. 
3.  You will be prompted to confirm that you want to delete the step. 

Click Yes to proceed.
4.  You can repeat this process to delete multiple steps. 
 Note: If you accidentally delete a step, you can click the Undo 

button on the Maths toolbar to undo up to your last eight changes.
5.  To navigate through your steps, click the 
 Go to Previous Step and Go to Next Step  

buttons on the Maths toolbar.

Printing your project
To print a project, click Print on the File menu.
You can also choose from the following options before printing:
 Selecting page orientation
 In Maths View, landscape orientation is the default. To switch to 

portrait orientation before printing a project:
����2Q�WKH�File menu, click Page Setup.

����1H[W�WR�Orientation, click the Portrait or Landscape icon 
(Macintosh).

 –or–

 Under Orientation, select Portrait or Landscape (Windows).
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Selecting paper size
 Letter is the default paper size in Kidspiration. To select a  

different paper size:
����2Q�WKH�File menu, click Page Setup.

����,Q�WKH�Paper list, select the paper size you want (Macintosh).

 –or–

3.  Under Paper, select the paper size you want in the Size list 
(Windows).

Printing page numbers
 If you choose to print page numbers, they will appear at the bottom 

of the page. To print page numbers:
����&OLFN�WKH�Pupil Name button.

����3ODFH�D�WLFN�LQ�WKH�ER[�ZKHUH�LQGLFDWHG�

Closing your project and returning to the 
Kidspiration Starter
Congratulations! You have completed Tutorial Two: Using steps to 
show progression of work. To close your project and return to the 
Kidspiration Starter, click the Go to Starter button.

When you return to the Kidspiration Starter, you are prompted to save 
the open project. Click Yes if you want to save the project. 
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Tutorial Three: Creating an open-ended  
problem in the Free Workspace
The Free Workspace allows for the creation of an open-ended problem 
where pupils can choose any tool with which to complete their work. 
A Maths Text Box from the Maths palette can be used to create 
instructions for the project, and then locked so it cannot be moved or 
deleted.
In this brief tutorial, you will learn to create a new project in the 
Free Workspace and see two examples of open-ended problems. 
For information on how to use the Maths Tools, refer to Chapter 4, 
Tutorial One. 

Starting Kidspiration®

To start Kidspiration on a Macintosh:
• Open the Kidspiration 3 IE folder and double-click the 

Kidspiration 3 IE icon.

The Kidspiration Starter opens.

To start Kidspiration in Windows:
Click the Start button, point to Programs and click Kidspiration 3 IE.
The Kidspiration Starter opens.
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The Kidspiration Starter is the place where you start new projects, 
open existing projects and use the many different Kidspiration 
activities. You will begin by clicking the Maths View button to open 
the Maths Tool Starter.

Starting a new Kidspiration project using the  
Free Workspace

1.  Click on Free Workspace on the Maths Tool Starter.

 A new workspace opens without a Maths Tool having been 
selected.

Adding your name to a project
1.  On the Maths toolbar, click the Pupil Name button .
2.  Type your name in the box where indicated.
 For the examples in this tutorial we will use the name “Glenna.”
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3.  To choose where you want the name to appear on the page, select 
Left, Centre or Right.

 A preview of how the name will appear on the page is displayed in 
the box on the right side of the dialogue box.

4.  Click OK.
 The pupil name appears in the title bar of the document.

Saving your work
1.  On the File menu, click Save.
2.  In the folder list, click the folder where you want to save the 

project.
3.  Type a name for the project, and then click Save.
 Kidspiration suggests the name “Glenna” based on the pupil name, 

but you can use a different name.
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Setting up your project in the Free Workspace 
with a Maths Text Box 
1.  Click the Maths Text Box in the Maths palette and drag 

it onto the workspace.
2.  Drag it into position wherever seems most appropriate.
3.  Type inside it to add project instructions or explain the problem to 

be solved.
 Note: If you make a mistake in your work, you have several 

options on the Maths toolbar:
• You can delete an item by selecting it and clicking the Clear  

button on the Maths toolbar.

 –or–

• You can undo up to the last eight changes in your project by 
clicking the Undo button on the Maths toolbar.

 –or–

• You can redo up to the last eight changes you used the Undo 
button to undo by clicking the Redo button  on the Maths 
toolbar. 
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Here are two examples of projects created in the Free Workspace, with 
open-ended problems:
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4.  Use the Bottom toolbar to change the style of text, add a border and 
a background colour to Maths Text Boxes, and to add operators and 
maths frames. 

5.  When working with Maths Text Boxes, click the arrow to the right of 
the Open Maths Frame button in order to see all of the 
Bottom toolbar.

Locking the Maths Text Box
Once your Maths Text Box is set up, you can lock it so it cannot be 
moved or deleted. 
• With text box selected, click Locked Item on the Teacher menu. 

 A tick appears next to Locked Item when the text box is locked, and 
the corner handles change on the box to look like this .

 Note: The Teacher menu must be enabled for the Locked Item 
option to appear. To turn the Teacher menu on or off, click Enable 
Teacher Menu on the Teacher menu. 

Creating a password for the Teacher menu
You can create a password for the Teacher menu to prevent pupils from 
using it and changing teacher preferences. 
1.  On the Teacher menu, click Application Options.
2.  Place a tick in the box next to Password Enabled.
3.  Click Set Password.
 The Set Password dialogue box appears.
4.  Type the password you want to use in the Enter Password box.
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5.  Type the password again in the &RQ¿UP�3DVVZRUG box, and then 
click OK.

 When you enable the Teacher menu, you will be prompted to enter  
your password.

 Note: If you forget your password, you can access the Teacher 
menu by using the password “Kidspiration3.”

Solving the problems
1.  First think about which tool would be best for each project.
2.  When you are ready to choose a Maths Tool, click the Maths Tools 

button on the Maths toolbar.

3.  Select the Maths Tool you want from the Maths Tools dialogue 
box, and you are on your way!
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Printing your project
To print a project, click Print on the File menu.
You can also choose from the following options before printing:

 Selecting page orientation
 In Maths View, landscape orientation is the default. To switch to 

portrait orientation before printing a project:
����2Q�WKH�File menu, click Page Setup.

����1H[W�WR�Orientation, click the Portrait or Landscape icon 
(Macintosh).

 –or–

 Under Orientation, select Portrait or Landscape (Windows).

Selecting paper size
 Letter is the default paper size in Kidspiration. To select a  

different paper size:
����2Q�WKH�File menu, click Page Setup.

����,Q�WKH�Paper list, select the paper size you want (Macintosh).

 –or–

3.  Under Paper, select the paper size you want in the Size list 
(Windows).

Printing page numbers
 If you choose to print page numbers, they will appear at the bottom 

of the page. To print page numbers:
����&OLFN�WKH�Pupil Name button.

����3ODFH�D�WLFN�LQ�WKH�ER[�ZKHUH�LQGLFDWHG�
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Closing your project and returning to the 
Kidspiration Starter
Congratulations! You have completed Tutorial Three: Creating an 
open-ended problem in the Free Workspace. To close your project and 
return to the Kidspiration Starter, click the Go to Starter button.

When you return to the Kidspiration Starter, you are prompted to save 
the open project. Click Yes if you want to save the project. 
 



147

Inspiration Software®, Inc.
Kidspiration® Software Licence Agreement

PLEASE READ THIS SOFTWARE LICENCE AGREEMENT (“LICENCE”) 
CAREFULLY BEFORE USING THE INSPIRATION SOFTWARE®, INC. 
SOFTWARE. BY USING, INSTALLING OR ACCESSING ALL OR ANY PORTION 
OF THE SOFTWARE YOU ACKNOWLEDGE THAT YOU HAVE READ THIS 
AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND BY THE TERMS 
AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE 
TERMS OF THIS LICENCE, DO NOT USE THE INSPIRATION SOFTWARE®, INC. 
SOFTWARE. IF YOU DO NOT AGREE WITH THE TERMS OF THE LICENCE, 
YOU MAY RETURN THE INSPIRATION SOFTWARE®, INC. SOFTWARE TO 
THE PLACE WHERE YOU OBTAINED IT FOR A REFUND. IF THE INSPIRATION 
SOFTWARE®, INC. SOFTWARE WAS ACCESSED ELECTRONICALLY, YOU 
MUST CLICK “ACCEPT,” INDICATING YOUR ACCEPTANCE OF THE TERMS 
AND CONDITIONS CONTAINED IN THIS AGREEMENT OR, IF YOU DO NOT 
AGREE TO THE TERMS OF THE LICENCE AND ACCESSED THE SOFTWARE 
ELECTRONICALLY, CLICK “NOT ACCEPT.”

In this Agreement, “Software” means the computer program and software known as 
Kidspiration Version 3. “You” or “your” means the end user and licencee of the software 
pursuant to this Agreement. “Inspiration Software” means Inspiration Software, Inc., an 
Oregon corporation.

GRANT OF Licence FOR USE ON ONE COMPUTER:  Inspiration Software grants to 
you a nonexclusive licence to use the Software on the temporary memory, hard drive or 
other storage device of one computer.  You must purchase a licence for each additional 
computer on which the Software is installed or can be used.  If the Software is installed 
on a computer which is usable by multiple work stations or on multiple computers 
connected by a network, you must purchase licences for each computer that can access 
or use the Software.  Without limiting any other right or remedy of Inspiration contained 
herein, you may not transfer the Software nor may you or any other person or entity use 
it or make it operable in any manner (or attempt to do the same) on any computer or 
work station other than the computer on which the Software is initially downloaded or 
installed.

Notwithstanding anything herein to the contrary, your use of all or a portion of 
Software content and materials accessible via the Internet (as described below), may be 

Inspiration Software®, Inc. Licence Agreement
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terminated (and the licence for your use thereof granted by this Agreement revoked), in 
whole or in part, by Inspiration Software, or its successors or assigns, at any time. 

PROPRIETARY RIGHT:  All right in and to the Software (including but not limited 
to any images, photographs, animations, video, audio, music, text, databases, 
examples, lesson plans, documentation, templates, symbols and software modules 
incorporated into the Software) are owned or licenced by Inspiration Software and 
are protected by law, including without limitation, U.S. and international copyright 
laws and international trade provisions.  You acknowledge the ownership, validity and 
enforceability in all aspects of all rights, including patent, copyright and trademark 
rights, that Inspiration Software has in the Software.  You will not participate in any 
attack on the validity or enforceability of Inspiration Software’s above-described rights 
whether in court, the United States Patent and Trademark Office, the U.S. Copyright 
Office, or elsewhere, or otherwise contest Inspiration Software’s above-described rights.  
It is in the intent of Inspiration Software and you that this paragraph shall have claim 
and issue preclusive effect.  You agree that the nature and quality of the Software will 
conform to standards set by Inspiration Software and otherwise be under the control 
of Inspiration Software.  You will not use the Software for any purpose other than as 
expressly provided in this Agreement, including without limitation, any unauthorised 
copying or distribution of, or other act with respect to the Software, that would violate 
any law. You may not modify, reverse engineer, decompile, disassemble, create 
derivative works, or otherwise change the whole or any part of the Software, nor may 
you deliver copies to, or sell, rent, lease, loan or sublicence the Software to any third 
party (other than as expressly provided in this Agreement).

LIMITED WARRANTY:  Inspiration Software warrants that any CD-ROM disc on 
which any portion of the Software is recorded will be free of defects in materials and 
workmanship under normal use for ninety (90) days after the original purchase.  If a 
defect occurs during such ninety (90) day period, you may return the CD-ROM disc 
to Inspiration Software for free replacement. Any replacement Software CD-ROM 
disc will be warranted for the remainder of the original warranty period or 30-days, 
whichever is greater; provided, however, that this replacement warranty is not available, 
nor will it be provided by Inspiration Software, outside of the United States of America.  
Inspiration Software disclaims all other warranties, either express or implied, including 
but not limited to implied warranties of merchantability and fitness for a particular 
purpose, with respect to the Software. In no event will Inspiration Software be liable to 
you for damages, whether based on contract, tort, warranty or other legal or equitable 
basis, including any loss of profits, loss of business, cost savings or other indirect, 
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special, incidental or consequential damages arising out of or related to the Software, 
even if Inspiration Software, or an authorised representative of Inspiration Software, 
has been advised of the possibility of such damages.  Subject to the foregoing, certain 
Software content may be available for use on your computer only through computer 
download via computer Internet access.  You understand that the operability and 
functionality of the Software may be dependent upon your computer’s performance 
capabilities, its capacity to access the Internet and the operability of computer servers 
or Internet web sites on which Software content may be stored or from which Software 
content may be accessed.  Without limiting any other matter contained herein, 
Inspiration Software does not warrant or represent that the Software will meet your 
requirements or that the operation of the Software will be uninterrupted or error-free.  
You bear all risk of loss for computer, Software or other malfunctions arising from 
access to or use of the Internet. The remedies set forth in this Agreement shall be your 
sole and exclusive remedies for any breach of this Agreement by Inspiration Software.

GENERAL:  All notices under this Agreement will be transmitted between the parties 
at the addresses identified below, or as otherwise designated by written notice from 
either party to the other. This Agreement contains the entire understanding between 
the parties regarding the subject matter of this Agreement, superseding all prior or 
contemporaneous communications, agreements and understandings between you and 
Inspiration Software; provided, however that this Agreement will not be construed to 
limit, but rather to augment, any other right or remedy of Inspiration Software contained 
in any shrink-wrap or other licence accompanying, relating to or incorporated into 
the Software, any operating manual or other related material, and the terms stated 
herein will supersede any inconsistent terms contained any such shrink-wrap or 
other licence.  This Agreement is binding on and inures to the benefit of the parties, 
their legal representatives, successors and assigns; provided, however, that except as 
otherwise provided herein, neither this Agreement, nor any rights granted hereunder, 
may be assigned, transferred, conveyed or encumbered by you without the prior written 
consent of Inspiration Software. This Agreement will be construed in accordance with 
the internal laws (and not the law of conflicts) of the state of Oregon, and it may be 
amended only in writing and signed by duly authorised representatives of both parties. 
If any provision or clause of this Agreement, or any portion thereof, is held by any court 
or other tribunal of competent jurisdiction to be illegal, void or unenforceable in such 
jurisdiction, the remainder of such provisions shall not thereby be affected and shall 
be given full effect, without regard to the invalid portion. This Agreement is neither 
intended to, nor shall it be construed as creating, a joint venture, partnership or other 

Inspiration Software®, Inc. Licence Agreement
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form of business association between the parties.  If any suit or action is filed by any 
party to enforce this Agreement or otherwise with respect to the subject matter of this 
Agreement, the prevailing party shall be entitled to recover reasonable attorney fees 
incurred in preparation or in prosecution or defence of such suit or action as fixed by 
the trial court, and if any appeal is taken from the decision of the trial court, reasonable 
attorney fees as fixed by the appellate court.  If you are a U.S. Government user, then 
the Software is provided with “RESTRICTED RIGHTS” as set forth in subparagraphs 
(c)(1) and (c)(2) of the Commercial Computer Software-Restricted Rights clause at FAR 
52.277-19

Inspiration Software, Inc,

9400 SW Beaverton Hillsdale Hwy, Suite 300

Beaverton, OR 97005-3300, USA
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